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AUTOMATED EMBRODERY STITCHING 

CROSS-REFERENCES TO RELATED 
APPLICATIONS 

0001. This application claims priority to U.S. Ser. No. 
60/081,333 filed Apr. 10, 1998, incorporated by reference 
herein, for all purposes. 

BACKGROUND OF THE INVENTION 

0002 With the advent of computer digitizers and embroi 
dery machines, users of embroidery machines and embroi 
dery Software have become more conscious of the need to 
reduce the time, labor, cost and user experience and exper 
tise needed to convert images into embroidery Stitch 
Sequences. An embroidery machine is a device which can 
accept as input a Series of movements and other actions (e.g., 
X/Y move, color change, thread trim, etc.) which correspond 
to a Stitch Sequence and Sew color Stitches onto fabric in an 
orderly fashion. 
0003. Before the use of computer software for assistance 
with generating Stitch Sequences for input to embroidery 
machines, a user needed to Simulate the proceSS used by 
hand embroiderers and Sewing machine operators. In par 
ticular, the user needed Visually to Select various Spots for 
receiving distinctive color and then to approximate those 
desired colored spots laying down Series of Stitch Segments 
and Sequencing the Series of Stitches. This process is 
extremely time-consuming and requires great experience. 

0004. Up to several hundred thousands of stitches or 
more are required to represent an image. Because of the need 
to use many different colored thread to cover many different 
areas many times, and the need to improve the embroidery 
machine's productivity, there is an additional requirement to 
organize the overall Stitch Sequence in an efficient way So as 
to minimize machine-Stop events Such as colored thread 
change and thread trim. Typically, Several days of labor are 
required to describe manually a Single, ordinary image as an 
adequate embroidery Stitch Sequence. 
0005 Since the days of purely-manual stitch sequence 
construction, Some workers have used computer digitization 
Software to perform a tedious step-by-step task of inputting 
information from an image into a computer. These tech 
niques involve the use of digitizer tablets or computer 
monitor Screens for detailed Step-by-step digitizing tracing 
or Selecting of distinctive borders from different areas of an 
image to identify the borders. Conventionally, a user must 
Select these border edges in Sequence to inform a computer 
that certain border curves can form a region. This process is 
Still time consuming and inconvenient. Once regions are 
identified, simple computer Software can be used to aid in 
generating certain types of Stitch Sequences for filling in the 
regions in a rudimentary manner. 
0006 Edge detecting algorithms are sometimes used to 
automate the process of edge identification from a computer 
image file. However, the edges detected by these approaches 
are usually broken and therefore do not form a closed region 
ready for Stitch generation. These broken edges convention 
ally need to be corrected manually before individual embroi 
dery Stitches can be computed from these regions borders 
and be placed within these regions following the user's 
instruction. 
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0007 One approach to generate these embroidery stitch 
Sequences is to divide the image into many Smaller but fairly 
uniform colored regions if Such regions can be found, and 
then according to the individual geometry of these regions, 
to pick different Style of machine thread Sequence to lay 
threads Such that these regions are covered. The threads 
generated in each region are in a very orderly way and 
almost parallel to neighboring threads. There are Several 
problems associated with this approach. One problem is that 
the Stitches generated in this way are too orderly and lack the 
fine appearance from most of the images. Secondly, very few 
images available today can be divided into regions of similar 
color in an obvious way, and thirdly, even for a simple 
images with clear borders of uniform colored regions, it may 
have hundreds of Smaller regions that need to be inputted 
into computer for Stitch generation, which is very labor 
intensive and time-consuming both in digitizing along the 
regions borders and in Selecting each of these Small 
region's borders to form the region. 
0008 Many images (e.g., photographs) are represented 
by bitmaps of a vast amount of different colored pixels 
distributed in a very mixed and complex manner. There is no 
art today to automatically convert an arbitrary image bitmap 
into a Series of embroidery Stitches in an efficient manner. 
The only existing approach for generating embroidery 
Stitches from this type of image is to hand-lay individual 
Stitch threads, one by one, locally in reference to the local 
details of image. Since this approach needs significant 
experience and vast amounts of labor for each task, it is not 
generally practical in the machine embroidery industry. The 
Stitches resulting from Such hand-placement and hand/Se 
quencing usually have no fixed order, appear to be very 
random, and frequently croSS one another, to the detriment 
of embroidery machine efficiency and in direct contrast to 
the types of Stitches currently capable of being generated 
automatically or with machine assistance. 
0009 Images exist today in the form of photos, paintings, 
artworks, prints, fabrics, or even computer files. The meth 
ods to convert Such images to bitmap data are well-known 
arts. A bitmap is an N by M points of color pixel data, either 
residing in a computer's volatile memory (e.g., random 
access memory, or RAM) or nonvolatile memory (e.g., hard 
disk). Bitmaps on one extreme could be highly organized 
with a single color repeated in every pixel. Bitmaps on the 
other extreme could be completely random in pixel color, 
shade, and distribution. Thus, one can Say that imageS as 
bitmaps exist in nearly infinite possibilities. The existing 
efforts to automate or partially automate Stitch generation 
achieve only a limited degree of Success, and for only a very 
limited range of image complexity/randomneSS. 
0010 Improved methods and systems are needed for 
automatic and/or machine-assisted embroidery Stitch gen 
eration from an image. In particular, Such improved methods 
and Systems should reduce needed time and human labor, 
especially skilled labor, during the Stitch-Sequence genera 
tion phase. Furthermore, the Stitch Sequences generated from 
such improved methods and systems should allow for effi 
cient Stitching by embroidery machines. In addition, Such 
improved methods and Systems should be operable for a 
Vastly greater range of image types. 

SUMMARY OF THE INVENTION 

0011. An automated image processing method and Sys 
tem for generating a representation of an input image. One 



US 2002/0183886 A1 

application is for reducing time and labor for constructing, 
e.g., computer embroidery Stitches from an input image. 
0012. According to another embodiment, a method for 
embroidering includes receiving a digitized representation 
of an image, determining a plurality of regions of the image 
in response to the digitized representation, and determining 
a geometric indeX for each region in the plurality of regions 
of the image. The method also includes determining a region 
type associated with each regions from the plurality of 
regions in response to the geometric indeX for each region, 
the region types including a first region type and a Second 
region type, embroidering representations of regions from 
the plurality of regions associated with the first region type; 
and thereafter embroidering representations of regions from 
the plurality of regions associated with the Second region 
type. 

0013. According to an embodiment of the present 
embodiment, a method for embroidering includes receiving 
a digitized representation of an image, determining grain 
Structures for a plurality of locations in the digitized repre 
Sentation, and the plurality of locations including a first 
location and a Second location. The method also includes 
embroidering a representation of the first location using 
croSS Stitch patterns, when a grain Structure for the first 
location indicates a bi-directional grain Structure, and 
embroidering a representation of the first location using 
uni-directional Stitch patterns, when the grain Structure for 
the first location indicates a uni-directional grain Structure. 
0014) According to another embodiment, an article of 
manufacture having embroidery Sewn thereon uses one of 
the methods described above. 

0.015 According to another embodiment, an embroidery 
System includes a processor, and a processor readable 
memory. The processor readable memory includes code that 
directs the processor to retrieve a digitized representation of 
an image, and code that directs the processor to determine a 
plurality of regions of the image in response to the digitized 
representation of the image. The memory also includes code 
that directs the processor to determine a geometric indeX for 
each region in the plurality of regions, code that directs the 
processor to determine a region type associated with each 
region from the plurality of regions in response to the 
geometric indeX for each region, the region types including 
a first region type and a Second region type, code that directs 
the processor to direct embroidering representations of 
regions from the plurality of regions associated with the first 
region type, and code that directs the processor to direct 
embroidering representations of regions from the plurality of 
regions associated with the Second region type after the 
representations of regions from the plurality of regions 
asSociated with the first region type. 
0016. According to another embodiment, a computer 
program product for a computer System including a proces 
Sor comprises code configured to direct the processor to 
receive a digitized representation of an image, and code 
configured to direct the processor to determine grain Struc 
tures for a plurality of locations in the digitized representa 
tion, the plurality of locations including a first location and 
a Second location. The computer program product also 
includes code configured to direct the processor to direct 
embroidering of a representation of the first location using 
croSS Stitch patterns, when a grain Structure for the first 
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location indicates a bi-directional grain Structure, and code 
configured to direct the processor to direct embroidering of 
a representation of the first location using uni-directional 
Stitch patterns, when the grain Structure for the first location 
indicates a uni-directional grain Structure. The codes reside 
on a tangible media. 

BRIEF DESCRIPTION OF THE DRAWINGS 

0017. In order to more fully understand the present 
invention, reference is made to the accompanying drawings. 
0018) 
0019 FIG. 2 is a flowchart of a method according to a 
Specific embodiment of the present invention. 
0020 FIGS. 3A-3C illustrate samples of different types 
of regions in coexistence. 
0021 FIGS. 4A-4C illustrate samples of different types 
of machined Stitches. 

0022 FIG. 5 illustrates an example of Subdivided type 2 
regions. 

FIGS. 1A and 1B illustrate example input images. 

DESCRIPTION OF THE SPECIFIC 
EMBODIMENTS 

0023. A specific embodiment of the present invention is 
directed to a method for automatic computer embroidery 
Stitch generation from an image, for reducing the time and 
color required to digitize an image. For best results, input 
images should be clear and large with fine resolution for a 
meaningful representation with embroidery Stitches. 
0024 FIGS. 1A and 1B illustrate example input images. 
In FIG. 1A, there is shown a cartoon-like image with 
qualitatively different features labeled 10, 20, 30, and 40 
which, as described below, variously correspond to Type 1, 
Type 2, and Type 3 image regions. In FIG. 1B, there is 
shown a photograph-like image that also includes cartoon 
type elements (bold text). FIG. 1B shows a scene with 
people in a boat, and textured water Splashing all about. Any 
other photograph that shows detailed variety in color, tex 
ture, pattern, orientation, etc., Such as of a cat, would also 
have made a fine example picture. 
0025 FIG. 2 is a flowchart of a method according to a 
specific embodiment of the present invention. FIG. 2 
includes steps 50, 60, 70, 80, 90, 100, 110, 120, 130, 140, 
150, 160, and 170. 

0026 FIGS. 3A-3C illustrate samples of different types 
of regions in coexistence. FIG. 3A includes a Type 3 region 
200, a Type 2 region 180, and a Type 1 region 210 within a 
Type 1 region 190. FIG. 3B includes a Type 3 region 230 
over and intercepting a Type 2 region 220 and over and 
intercepting a Type 1 region 240. FIG. 3B also includes a 
Type 2 region (220) intercepting a Type 1 region (240). FIG. 
3C includes a region 250 that is then uncoupled into a Type 
1 region 270 and a Type 2 region 280. 

0027 FIGS. 4A-4C illustrate samples of different types 
of machined Stitches. FIG. 4A illustrates running stitches, 
which are suitable for Type 3 regions. FIG. 4B illustrates 
ZigZag Stitches, which are Suitable for Type 2 regions. FIG. 
4C illustrates various filled Stitches, which are Suitable for 
Type 1 regions. 
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0028 FIG. 5 illustrates an example of Type 2 regions 
which have been further subdivided into smaller regions. 

The Nature of an Image or Region 

0029. In general, an image can be as simple as a cartoon 
drawing (FIG. 1A) or as complicated as mixture of artwork 
and photos (FIG. 1B). According to the present invention, 
the complexity/randomneSS, or “nature', or “composition,” 
of an input image or regions within the input image is 
automatically determined. This is shown in Step 50 of FIG. 
2 for the specific embodiment. 
0.030. According to the present invention, separate meth 
ods appropriate to each level of complexity/randomneSS are 
employed. In the specific embodiment of FIG. 2, two levels 
of complexity/randomneSS are handled by two branches of 
method steps, namely Steps 60-130 and Steps 140-170. 

0.031) For determining the nature of an input image (e.g., 
Step 50), measurement entropy which is used in the study of 
deterministic chaos can be adopted. See Reference 2). 
0032. A large class of images result from photographing 
3-dimensional real objects Such as people, animals, plants, 
and Scenery. These images are composed of mixtures of light 
Signals from large numbers of randomly oriented Surfaces 
which emit, reflect, absorb, and transparently or translu 
cently transmit colors. In Such images, the elements seem 
random but actually all have Something in common, e.g. a 
Same lighting Source, a Same nature of material in certain 
area(s), etc. The theory of deterministic chaos can be 
adopted. 

0033. The specific embodiment take as its starting point, 
an image to be analyzed for finding the inherent properties 
of different regions, in order to apply pertinent ways to 
generate computer Stitches. In the Specific embodiment, an 
image can be divide into chosen Small regular regions for 
determining its properties, according to, e.g., known image 
processing techniques. If there is enough Similarity in neigh 
boring regions, they can be grouped into larger regions for 
further processing. If certain region exhibits regularity, 
technique revealed later in this paper can be used to extract 
Simple images out. 

0034 Consider each smaller region. According to defi 
nition of measurement entropy for nonlinear dynamic Sys 
tem, the Kentropy is the most important measure of chaotic 
System, it measures the average rate of loSS of information, 
if K is 0, then the system is fully deterministic; if K is 
infinity, then the System is completely random. Otherwise, 
the System is deterministic chaos. 
0035). According to definition: 

K = LimTLim 
e-0 12-seat - 12 

let, i2) 

where 

let, i2 = -X P(i. i2, ... i.)lnPi, i2, ... i.) 
(i) 

0036) and P(i,i, ... i.) is when after the state space was 
reconstructed into n dimensional Space with unit length of e, 
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and when time between t to t was divided into n intervals, 
the joint probability of its State falling into these grids. 

0037 For image processing, the data can be viewed as the 
information from a dynamic System in different Stages. 
Following Reference 3. Approximate entropy is an effi 
cient way to compute for measurement entropy. 

0038) Typically, the data making up a time series x(t)}, 
i=1,. . . . , N, are of lower dimension than the actual 
dynamics. 

0039. After the state space reconstruction using the delay 
vector of embedding dimension M, the series of M dimen 
Sion vectors are: 

X(1), X(2), ... X(N-(M-1)L) 

0040 where 

0041 define as delay vector. 

0042 N is the total sampling point count and L is the 
Sampling interval count. 

0043. Define the distance between vector X(i) and XG) 
S. 

0044) Define: 

(the total numbers count of J's for 
N - M + 1 X varying J, under the condition of 

dX(i), X(f) <r) 

and : 

1 N-- 
Mr Y - X M d" (r) = N - M + 1 i=1 lnC" (r) 

0045 Approximate entropy ApEn(Mr.N) can be defined 
S 

0046 Values of M, r, N and L can be chosen to adjust the 
Sensitivity for detecting different image natures, where M=2, 
r=0 to 15, N=500 to 1000, L=1, can yield satisfactory results 
for common image types. In other embodiments of the 
invention, other ways to approximate entropy may be used. 

0047 The above expression is used to evaluate the local 
nature of images ranging from the Simple cartoon artwork to 
complicated photoS. For example, values of the expression 
may be compared with predetermined threshold value(s), 
and values to one Side of a threshold would indicate one 
nature and values to the other Side would indicate another 
nature. Once the nature of image is identified for many 
sub-areas of the image (Step 50 of FIG. 2), methods from 
the Specific embodiment of the present invention, e.g., 
macroscopic Stitch generation or microScopic Stitch genera 
tion, can be applied to designated area of image for auto 
matic Stitch generation. 
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0.048 Macroscopic Stitch Generation 

0049. In Step 60, the cartoon-like or simple artwork type 
of image is partitioned into regions of fairly uniform color, 
and a border is determined for each region. 

0050 For cartoon-like or simple artwork type of image, 
well-known techniques Such as the quantification of each 
image pixel based on RGB or UVW space is used to assign 
a quantified number to each pixel. Examples of Such well 
known image processing technique is discussed in Refer 
ence 1. The result of Such calculation assigns a quantified 
number to each pixel. Scanned Samples of already embroi 
dered work can be processed by this Same method. 

0051. For every pixel in the image, compare the quanti 
fied number with that of all adjacent pixels. If the difference 
of this number is Small enough, based, e.g., on comparison 
with a predetermined threshold, one can Say that their color 
are Similar and can be merged into a Same region. This 
proceSS is repeated until all the pixels are used and all the 
regions are formed. It is relatively easy to find all the pixels 
on the border of each region and therefore each region has 
pixels on the border and pixels not on border. 

0.052 In Step 70, a metric (or multiple metrics, in other 
embodiments) is computed for each region that is indicative 
of its geometric quality. From this metric, the each region 
can be classified according to a geometry classification 
System. In the Specific embodiment, the metric measures the 
“thinness” of a region's shape. 

0053) One can perform the pixel count P for border 
pixels and the pixel count PA interior area pixel including 
border pixel for each region. A geometry index I can be 
formally defined as, e.g., 

0054. This is a preferred formulation of the geometry 
index I. The higher the index, the more “thin' is the region, 
and the lower the index, the more “thick,” or “full,” is the 
region. Other metrics for geometry indices may be used to 
determine “thinness.” 

0.055 For example, any expression that tends to get larger 
(or Smaller) as PB exceeds PA would have Some utility. For 
example: 

0056. The macroscopic approach of the specific embodi 
ment takes each region's geometry index I as its starting 
point. From these indices I, the regions are classified into 
Some number of geometry types, e.g., by comparison with 
threshold values, along with other considerations. The 
threshold may be predetermined by testing the Specific 
System in question with a variety of input and finding the 
values that give good performance. 
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0057 With illustrative reference to FIG. 1A: 
0.058 1. Regions labeled 10 (type 3) are thin curve 
like region with very high index I value; 

0059 2. Regions labeled 20 (type 2) are thicker in 
local width compared with region type 3, therefore 
moderately high index I value; and Regions labeled 
30 (type 1) are relatively large area and with similar 
dimension when measured on two perpendicular 
axes, the value of index I is Small; and 

0060) 3. A region labeled 40 (type 4) has pixels on 
the exterior edge of the image and upon further 
analysis may be recognized as background region. 

0061 FIG. 1A is an example of just one simple image for 
embodying the present invention. It will be readily apparent 
to one of ordinary skill in the art that a vast number of 
images are Suitable for use in conjunction with the present 
invention. More specifically as non-exhaustively illustrated 
in FIG. 3, the first 3 types of regions can be nested or 
intersected or separated with each other in many ways and 
in lots of images, any combination of two types of regions 
mentioned previously are also considered Suitable for the 
present invention. For ease of future of operation, Some 
region can be split into 2 or more different Type 2 or Type 
1 regions, judging by the geometry difference in different 
portions of this region. If all region's colors add up to exceed 
allowable colors from the designated embroidery machines, 
Similar colored regions can be forced to have a same color, 
to thereby reduce the overall number of colors used. 

0062. In the specific embodiment, if local coexistence of 
Type 3 of area (thin curve-like) with Type 1 or Type 2 of 
areas, Type 3 area is always embroidered last and overlaid 
on previously embroidered Type 1 or Type 2 areas. 

0063. In Step 80 of the specific embodiment of present 
invention, all Type 3 regions are extracted first and are fitted 
with Spline curves. In later Steps of Stitch generation, these 
curves will be organized and embroidered last Such that they 
can be overlaid on previously embroidered Type 1 and/or 
Type 2 areas. A representation of actual embroidery Stitch 
for Type 3 areas is called running Stitches is shown as 290 
in FIG. 4A. The pixels belonging to extracted Type 3 area, 
i.e., the Void can be changed to the color number of adjacent 
region's pixels, be ready for next round of operation. 

0064. In the specific embodiment, slight color variations 
are allowed within Type 1 and/or Type 2 regions. The 
techniques to be cited later in this paper can be used to obtain 
detailed image grain Structures and orientations shading 
distribution directly from the original input image, which 
has not been quantized into regions each of uniform color. 
This image nature information is then Saved and later is used 
for Stitch generation within these areas. This is a powerful 
feature which greatly adds to the quality of the output 
embroidery for many types of input images. 

0065. In Step 90, once all the Type 3 regions were 
identified and extracted, the next Step in the Specific embodi 
ment is to operate on Type 2. Many pairs of Spline curves are 
derived and fitted across all local width (FIG. 5), each Type 
2 region is divided into many 4 sided sub-regions 320. Once 
these 4 sided Sub-regions are adjusted along the border to 
reasonable geometry, ZigZag or satin stitches (FIG. 4B) 300 
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are generated for each Sub-region, and hence for the whole 
Type 2 region, according to known methods in the art. 
0.066. In the specific embodiment of this invention, the 
following criteria can be used to evaluate a Type 2 region: 

0067. 1. The area of this region is relatively small. 
0068 2. The geometry index I is relatively large. 
0069. 3. The region is completely fit into other 
region. 

0070 4. The region is in between two or more 
regions of the Same color. 

0.071) If the subjected Type 2 region satisfies most of 
these criteria, this region can be set as an option to be 
extracted out and later be overlaid as Stitches on top of 
Stitches previously embroidered from other regions. In that 
case, the pixels which used to be in this Type 2 region (i.e., 
the Void) can be changed to the color of adjacent regions. 
Thus, there is a step of determining whether the Type 2 
region should be overlaid on top of other Stitches. 
0.072 In the case of a Type 2 region is in between the 
border of 2 or more Type 1 regions of Same color, if this 
Type 2 region is extracted out for generating overlaid 
Stitches, the present invention takes these bordering Type 1 
regions and group them into one Type 1 region. 
0073. In the next Steps 110 and 120 embroidery stitches 
within each of the Type 1 regions (FIG. 4C) 310 are 
computed. With or without the use of previously computed 
image composition (“image nature”) information, Type 1 
region may have one or more Type 2 regions embedded 
within. 

0.074. In Step 130, the specific embodiment provides a 
means to find the image information composition and be 
used as a reference for generating embroidery Stitches 
directory from the border of this region. 
0075. The specific embodiment of this invention can find 

its application in automatic Stitch generation from a Scanned 
Sample of actual embroidery work. The local image grain 
directions described later, in conjunctions with the finding of 
regions and borders can be adopted. 
0.076 AS to the region of Type 4 (background region) 40, 

it is usually optionally omitted and need not be of concerned. 
If there is a need to also generate Stitches for any or all of 
this type of region, the method used is identical to those 
described previously for Type 1 or Type 2 regions. 
0077 Microscopic Stitch Generation 
0078. As stated previously, a large fraction of the images 
in the form of computer bitmaps are taken from photos of 
complicated 3-D objects. Using the method described pre 
viously, bitmaps can be found as deterministic chaos, in this 
case, both the pixels distribution and edge extraction are 
very fragmentary and it is very difficult to use it to generate 
embroidery Stitches. Even if Some of the images can be 
approximated by identifying regions for Stitch generation by 
the method Stated previously, the resulting Stitches could 
appear too orderly and plain. 
0079 The specific embodiment of present invention use 
a method to link local adjacent pixels for forming the 
embroidery stitches directly, without the need to find borders 
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of region containing these local pixels. Using a high reso 
lution computer monitor as an example, each pixel is about 
0.25 mm, comparable to embroidery thread width, between 
4 and 20 pixels could be linked to a line Segment, which is 
comparable to the machine embroidery Stitch length, com 
monly between 1 mm to 5 mm. Thus the automatic steps 
needed are to find the distribution, Stitch length and 
Sequence for all different colored Stitch Segments. This is a 
difficult problem and has likely not been previously unex 
plored. 

0080) 
0081) 
mined. 

Image Grain Structure Determination 
In Step 140, the image grain Structure is deter 

0082) Applying the well-known technique of two-dimen 
sional DFT, Reference 1). A 2-dimensional discrete Fourier 
transform (DFT) of a Sampled 2-D signal h (kka) is given 
by 

N- W 

where n1 = 0, 1, 2, ... , N - 1 

and n2 = 0, 1, 2, ... , N - 1 

0.083. In discretized form, k.k. is the location number of 
local pixels, in continuous form, using u, u' instead of n, n, 
define a power H(u, U) as: 

0084 for slowing down the decreasing of spectra in 
increasing frequencies. 

0085 Repeatedly apply DFT to predetermined locations 
of images over its adjacent region, T(u, u) values are now 
computed for each predetermined location point within this 
image. 

0.086 Transform T(u, u) into the polar coordinates of (r, 
(p) 

0087. Define 

0088 where 

0089 means, for each r value, one can find H value 
around the circular path of fixed r. 
0090 Similarly, define 

T(b) = X T(ri, (b) 
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0091 where 

0092 means, for each p value, one can find H value along 
the r direction. 

0093. One can now investigate the curve of T(cp) VS. (p 
and find number of wave peak, denote it as N. Following 
result can be recorded: 

0094) a. if N is equal to 1 or 2, then it is clear that 
there is Uni. Orbi-directional grain Structure around 
this point. In this case, the grain directions can be 
easily determined; 

0.095 b. if T(r) is constant, then it indicates that there 
is no directional grain existing at this point, 

0096 c. if T(r) fluctuates, it indicates that images 
near this point are very fragmentary and Spotty; and 

0097 d. finally, if N is changing rapidly from point 
to point in a Small region of image, it indicates that 
there is a pattern in this region and one can repeat 
edly use the same technique of DFT over a refined 
grid to find detail of this pattern. 

0098. The specific embodiment of present invention uti 
lizes previous findings as in a, b, c and d, for reference to 
derive the pixel linking and line forming process in the 
following manners. 

0099 Case a: local pixels are linked parallel to the 
local grain direction found previously and it also 
means that parallel Stitches are created for Uni.- 
directional grain and croSS Stitches are generated for 
bi-directional grain. 

0100 Case b: local pixels are linked parallel to a 
fixed given direction. The result could either be one 
direction Stitches or bi-directional Stitches. 

0101 Case c. local least square method are adopted, 
for pixels distributed in local (x, y) random Stitches 
could be found. 

0102) Case d: pixels will be linked to closely follow 
the details of patterns. 

0103) Each line segment can be made short (using fewer 
pixel) or long (using more pixels) according to the local 
color intensity of these pixels. Thus, shorter Stitches have 
more dense Stitching needle points can contribute to darker 
shade and, longer Stitches have fewer needle points can 
contribute to lighter Shade. 
0104. In the specific embodiment of this invention, a 
large number of individual same colored short line Segments 
in the same area can be connected together by tie-in pairs of 
most closely situated end points from each line Segment 150. 
Many of the as-tied end points can be merged into one point 
if the distance between them is too small. This line linking 
proceSS is continued until the current end point can not find 
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a nearest end point with acceptable distance. This process 
can temporally be hold and the already connected line 
Segments can form a group 160. The proceSS is continued 
until all the line Segments are used in forming many groups. 
0105. One note worth taken is that the starting and end 
point of any group of lines can be Switched or made to 
coincide as one point (in this case, one extra underlay line 
of Stitch is generated under this group of lines.) This 
property of changeable Starting and ending point in a group 
of lines is very important as it provides more flexible ways 
to connect group of lines. Interactive test could be used to 
find the right Sequence of connecting all various group of 
lines from different color, Such that the occurrence of long 
exposed connecting line between groups are minimized 170. 
0106 The embroidery field can sometimes still be con 
sidered as an art and without any fixed and unique way for 
Stitch preparation. The System and method described herein 
can process a large class of input images. For certain images, 
a better final result can be achieved after making slight 
modification to either the Stitch Sequence generated by the 
Specific embodiment or to the image itself (for reprocessing 
by the present invention). 
0107 The invention has now been explained with refer 
ence to Specific embodiments. The present invention relates 
to methods and Systems for deriving information from 
images and generating command Sequences from Such infor 
mation for creating Stylized renditions of those images. A 
particular application is to machine embroidery wherein the 
present invention generates embroidery Stitch Sequences and 
optionally operates an embroidery machine using the gen 
erated Stitch Sequences as an input. 
0108. Other embodiments will be apparent to those of 
ordinary skill in the art in View of the foregoing description. 
For example, the "Stitch Sequences' could also correspond 
to a generic line-art representation of images, which have 
aesthetic appeal even when printed on other media or when 
displayed on a computer display. 
0109) It is envisioned herein that the present invention 
will find its implementation in a Software program on a 
computer-readable Storage medium within a computer Sys 
tem, wherein the computer System may be coupled to Send 
its output to an embroidery machine and which computer 
System may form a part of an automated embroidery System. 
Such an embodiment is therefore to be considered within the 
Scope of the present invention. Other embodiments are 
described in the attached appendicies. 
0110. The scope of the invention is therefore indicated by 
the appended claims rather than the foregoing description 
and all changes that come within the meaning and range of 
equivalents thereof are intended to be considered as being 
embraced within their scope. It will be appreciated by those 
skilled in this particular art that the present invention can be 
embodied in other Specific forms without departing from the 
Spirit or essential characteristics thereof. 
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Welcome to AutoStitch 

Thank you for using AutoStitch, the world's most powerful automatic embroidery-stitch generation and design 
system. AutoStitch integrates image processing, automatic stitch generation, an object based system, 
powerful editing, and true 3D VR preview into one easy-to-use product. 

For novice users, simply get the image then select the generation button once for Creating stitch, prestol 
Stitches are created automatically within minutes and ready to use it on machine. 

For professional users, AutoStitch has very complete editing features for users to fine-tune the computer 
enerated stitches to suit individual's preferences. 

What is AutoStitch 

AutoStitch is an advanced embroidery-stitch design system for Microsoft Windows'95 and Window'NT that 
has revolutionized the way users design their embroidery stitches. 

With AutoStitch, the user can employ desktop computers to quickly finish his designs, high quality designs 
which a year ago were possible only by using a digitizer or mouse manually. In other words, AutoStitch helps 
the user to create, edit, calculate, and save designs, automatically. 

Once the image or design has been created or imported into AutoStitch, the program can automatically 
calculate the stitch for your design an ability that places AutoStitch far ahead of its competitors. 

AutoStitch provides a new level of creativity for embroidery designs: 

Automatic scanner input with image enhancement 
Multiple methods of image insertion and editing 
Dual views for image processing and stitch generation 
Automatic image analysis for stitch type, stitch region generation, and sequencing 
Advanced CAD natural input" 
Convenient and powerful editing tools 
Object based 32 bit design for Windows(895 and Windows(BNT 
Area list for manual sequence change, view, and operation control 
True 3D virtual reality viewing 
Ability to automatically convert millions of clipart and thousands of fonts into embroidery stitch 
Photo realistic 3D image rendering 

AutoStitch is the core system for stitch generation, optional PhotoStitch, FeatureStitch systems should be 
used to process photos before using AutoStitch. 

"topic 
welcome to AutoStitch 

* Welcome to AutoStitch 
"topic-2 
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* What is AutoStitch 
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PhotoStitchi Feature StitchTM Stitch CADTM 

p 

AutoStitch 

eptional Stitch CADtv system 

Getting Around 

When you run AutoStitch, you will normally find two sub-windows, a menu bar, five toolbars, a color list bar, 
ii, and a status bar on the SCreen, 

Sub-Window 
Menu bar 
Status bar 
Color List bar 
Toolbar 

Left-click an object to select. 

: You can drag a rectangular frame by left-clicking or holding down the Ctrl key and then dragging. Left-click 
Can also be used to select several Consecutive or inconsecutive objects. 

Left-clicking one or several objects twice will transfigure and rotate the selected object(s) manually and auto 
visually. 

Right-clicking once will activate an area or a line. 

Dragging a rectangular frame or holding down the Ctrl key and then right-clicking will select several 
Consecutive or inconsecutive area(s) or line(s). 

Right-clicking one or several objects twice will retrieve the relevant shortcut menu of the activated area(s) or 
lines. 
Sk 

System Requirements 

The minimum system requirements for your computer to run AutoStitch are: 

to 30MB hard disk space to install AutoStitch 
o Pentium processor 
e 32MB of RAM 

"topic-3 
getting around 

k Getting Around 
t topic-4 
s system requirements 
* System Requirements 
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e A monitor and video card capable of displaying 1024x768, 65536 color resolution 
e A Windows-Compatible mouse 
o Microsoft Windows 95, Windows NT 
o Parallel port for security dongle 

To improve overall AutoStitch performance, you may want to consider upgrading your system hardware, e.g. 
Pentium Il, Pentium PRO processor, 64MB or more for RAM, large screen monitor, etc. 
The AutoStitch system is not designed for use on Windows 3.x operating systems. 

Optional Equipment 

o Color-SCanner 
Color-printer 

Sk 

Technical Service 

If you encounter any problems while installing or using this product, please contact your ZSK representative or 
use Our Web site Support System to see the latest news, tips, or to submit your complaints, suggestions or 
encountered bugs. 

Instal AutoStitch 
isk 

Create a Shortcut 

If you want to Create a shortcut to the AutoStitch program on your Windows95 or Windows NT desktop, follow 
the steps below: 

1. Right-click your mouse in a blank space of the desktop. 

2. Click New, and then select Shortcut. 

3. Enter the path for the AutoStitch program in the command line, or click the Browse button to appoint the 
path for the AutoStitch program, and then click Next. 

4. Enter a name for the shortcut such as "AutoStitch", and then click the Finish button. 

A new icon will be created on your Windows95 or Windows NT desktop. Double-click the new icon to run the 
AutoStitch program. 

Tip. 

You can also create a shortcut to the AutoStitch program by: 

1. Finding the AutoStitch.exe file under the AutoStitch directory using Windows Explorer. 

topic-5 
optional equipment 

* Optional Equipment 
"topic-6 
technical service 

* Technical Service 
"topic-7 
install AutoStitch 

* Install AutoStitch 
"topic-8 
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2. Right-click the file and then select Copy. 

3. Right-click a blank space on the desktop. 

ASk 4. Select Paste Shortcut. 

Getting Help 

AutoStitch provides the user with plentiful help information, which helps the user to understand the various 
commands and operations of AutoStitch. Help is available through the following ways in AutoStitch. 

o Use "Help Topics" in the "Help" menu to browse among all the help topics. 
o Press F1 to browse among all the help topics. 
• Use "Search" commands in "Help" menu to search for your desired help topic. 
e Click the Question Mark button on the upper-right corner of the dialog box to get your desired help 

options. 

o Use "Help” menu 
: Get help in the dialog box 

Use Help Menu 

To browse AutoStitch Help topics, Select Help topics from Help menu. Two tabs "Directory" and "Index", are 
on the top of the Help topic dialog box. 

; Click Index tab, you can enter your desired help topic or select one in the list box, and then click Display 
button. 

"Directory” tab classified the help topics according to its classification. Double-click the book-like icon (S) 
which is in front of every help topic to view the detailed help topics. If the book-like icon appeared again, 
double-click it again until the question mark icon appears. Double click any help topic, you can get your 
desired help text window. 

in help text window, you can see some words or phrases are underlined with dotted lines or real lines, which 
are called "Key Words". Move the cursor to the "Key Words", the cursor will become a hand. Click the "Key 
Words", the definition or some relevant information about it will appear on the screen. 

o if the "Key Words" are underlined with dotted line, it indicates that the displayed help information will 
disappear if you click any position on the screen. 
e if the "Key Words" are underlined with real line, it indicates that to click "Back" button can return to the 
previous help text window and to click "Directory" can return to the help topics window. 

• To return to the present AutoStitch window, click the "Close" button X, which is on the upper-right Corner of 
this Window. 
o To return to the help topics window and go on searching for your desired help topic, click the "Directory" 
button which is on the top of the window. 

Get help in the dialog box 

Having opened a dialog box, you can click the Question Mark? button which is on the upper-right corner of 
this dialog box if you are not familiar with the function of some buttons or options. 

topic-9 
getting help 

* Getting Help 
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When click this button, the cursor becomes an arrow with a question mark. After that, click any option whose 
relevant information is desired in the dialog box, AutoStitch will offer you an indication box, which contains the 
relevant information about this option. To close the indication box, click any position on the Screen and the 
user can go on to do other operations." 
Starting AutoStitch 

Use the following method to start AutoStitch. 

o if the AutoStitch program is installed in the Start menu, click the Start menu, and locate the AutoStitch 
Sub-menu. Point the Cursor to it and then click AutoStitch. 

o if the AutoStitch program exists only on the hard disk, you can: 

(1) Click the Start menu, point the cursor to the Program menu, locate the Windows Explorer Sub-menu 
and click it. 

(2) Change the drive, locate the directory in which AutoStitch exists and then double-click to open it. 
Locate the AutoStitch.exe file, double-click it. 

You can also run the AutoStitch program by clicking the Startmenu, select Run, and then enter its path or 
click the Browse button to appoint the path for the AutoStitch program, click OK to run the program. 

If you created a shortcut to the AutoStitch program, double-click the shortcut's icon to run the program. 

After the user inserts an object, its size may need to be modified. Use Resize to fulfil this operation. 

1. Left-click to select an object that you'd like to resize. 

2. Select Resize from the Edit menu. 

3. In the pop-up Resize dialog box, double-click the width and height input box under the New Size option 
and type your desired value. Once you have checked the Maintain aspect ratio checkbox, type your desired 
value in one input box. Now click another input box, the calculated width or height will appear automatically 
by a certain proportion and in response to the height or width you entered. Thus, the user doesn't need to 
enter the height and width value independently. 

4. Click OK. 

5. Click Generate. 

Tips: 

1. AutoStitch also provides the user with a convenient and auto-visual way of resizing. The user 
does not have to select Resize from the Edit menu, instead one can do it directly in the Object View 
Window. 

2. To resize several objects at the same time and to the same relative proportions, group these 
objects first and select them as a whole to resize. After this operation, ungroup them. Considering 
the accuracy of ungrouping, this method is often applied to characters. 

topic-11-12 
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"topic-11-13 
resize 

* Resize 

  

  



US 2002/0183886 A1 Dec. 5, 2002 
12 

3. AutoStitch also provides the user with a convenient and auto-visual way of resizing. The user 
does not have to select Rotate from the Edit menu, instead one can do it directly in the ObjectView 
window. 

Note: 

HSk 

While using Resize, you must left-click to select an object and you can only left-click to select one 
object to participate in the operation at one time. 

A Convenient and auto-visual way of resizing 

AutoStitch also provides the user with a convenient and auto-visual way of resizing. The user does not have 
to select Resize from the Edit menu, and can do it directly in the Object View window. 

1. 

2. 

Left-click to select an object in the ObjectView window. 

Eight black points will appear outside the object, move the cursor to any one of them, the cursor will 
become a double-head arrow; one points inside and another outside. 

i 

Drag the cursor according to the arrow direction to resize the present object. 
To reduce the object, drag the cursor toward the inside-arrow direction. 
To enlarge the object, drag the cursor toward the outside-arrow direction. 
To change the width and height of the present object, drag any one of the four points in the four corners. 
To enlarge or reduce the height of the object, drag any one of the two points lying on the horizontal lines. 
To enlarge or reduce the width of the object, drag any one of the two points lying on the vertical lines. 

. Click Generate. 

Tip. 
To resize some objects by X or Y direction, if users hold down the Ctrl key and then drag the mouse 
to resize, the size of these objects will not be changed, instead, what is changed is the distance 
between these objects in X or Y direction. However, the spacing problem in X or Y direction should 
be existing when you perform this operation, otherwise the operation is meaningless. In addition, 
holding down the Ctrl key and then dragging the mouse can only change the distance between these 
objects in X or Y direction. This function is valid only when you drag them by X or Y direction. It is 
invalid if you drag them in a diagonal line. 

Sub-window 

The left-side sub-window is called the Picture View window, which is used to display the source picture of 
the design file. When there is a source picture in the Picture View window, double-click the window to edit 
it. Only one source picture can be displayed in the Picture View window at one time. 

The right-side sub-window is called the Object View window, which is used to form various design files, 
stitch files, or some other files. When there is an object in the ObjectView window, use the various 
functions of AutoStitch to edit it. Several objects can exist in the ObjectView window at the same time. 

Left-clicking can activate either Picture View window or ObjectView window, but only one of them can be 
activated at One time. 

To close the activated Picture View or Object View windows, click the x button. If one clicks the x button in 
the Picture View window, the window will close, the ObjectView window will then enlarge to fit the whole 

"topic-11-14 
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AutoStitch window. To return the original Picture View window, click the E button on the upper right corner of 
the Object View window. The Picture View and Object View window can exist at the same time, but they can 
not be closed at the same time. 

o Move the cursor to point to the split bar which lies between the two sub-windows, the cursor will become 
-|-. By dragging it towards the arrow directions, the size of the two windows will be adjusted. 

Menu bar 

The Menu bar contains the File, Edit, View, insert, Outline/Block/Stitch, Accessories, and Help menus, and 
they have their sub-menus under them. 

Tip. 

if the menu bar is not displayed on the screen because of an error in operating, double-click the gray 
double-line bar which is on the left-side of the menu bar and equal to the title bar in this menu bar. 

Status bar 

i" Once there is a generated object in the ObjectView window, the color list bar will display all the color blocks 
of the object in the present window. 

Color List bar 

Once there is generated object existing in the Object View window, the color list bar will display all the color 
blocks of the object orderly in the present window. 

Scanning Picture 

The following ones are only basic principles other than absolute criteria. Everything should be proceeded 
from the actual situation. 

1. Avoid scanning magnified dithered pictures which are originally very small, for it is quite likely to get bad 
effect. 

2. Often a picture should be scanned in its original size, and its dpi should be neither too large nor too small. 
If different sizes are desired, we recommend you to use AutoStitch's Resize function. 

3. A color picture is often scanned in its true colors (millions of colors), and you should avoid using 16 colors 
and 256 colors to Scan it. 

4. A black-and-white picture can be scanned in Black and White, for its scanning effect is probably better than 
that of true Colors. 

5. The recommending way of scanning is to save the scanned picture as a disc file and then to process it 
further. Thus, you can make necessary modifications outside AutoStitch and try different options to process it 
repeatedly, otherwise you'll probably get different effects after each scanning, 
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Load a Design 

AutoStitch provides the user with several ways to load a Design. You can load a design: 

Using the Load dialog box 
Using the most Recent Files list 
Usind My Computer or the Windows Explorer 
Using Drag-and-Drop 
Using the Run dialog box 

Using Load dialog box 

Load dialog box is a standard dialog box with Some fundamental features. 

g Step by Step Instructions 

To load a design that you have used recently, select Recent Files at the bottom of the File menu, and 
then click its name. 

When you first use the Load dialog box, the AutoStitch folder is the default folder. The AutoStitch 
folder is located at the root level and is a good place to store the designs and databases you are 
currently working on. 

Step 1: Access Load dialog box p 

There are two ways to access the Load dialog box: 

o You can click Load Design from the File menu. 

: You can click on the Load Design button V in the Toolbar. 

Step 2: Select file's folder {s a 

Using the following controls to select a folder: 

O Look in box 
O Up One Level button 

Contents List box 
Look in box 

Look in box lists the currently-selected folder and all the folders above it, including the Windows system 
folders (Desktop, My Computer, etc.). 

"topic-20-21 
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To select a folder. 

1. Click on the drop down box to open it. 

2. Click on your desired folder to select. If the folder is invisible, use the scrollbar to move through 
the list. 

Up One Level button 

Clicking on Up One Level button takes you to the folder that directly contains the current folder. For 
example, if the current folder is C:WUTOSTITCH\DESIGNS, clicking on the button will take you to 
CWUTOSTITCH. 
Contents List box 

The Contents List box displays the contents of the folder that is currently selected in the Look in box. 

To select a folder: 

1. Click on your desired folder. If the folder is invisible, use the scrollbar to move through the list. 

it 2. Click on the Open button. AutoStitch will update the Look in box and the Contents List box. 

Step 3: Select File Type (s a 

Select the file type from the File Of Type. 

1. Click on the drop down box. AutoStitch will open it. 

2. Click on your desired file type to select. If the file type is invisible, use the scrollbar to move 
i through the list. 

Step 4: Select file 1q ed 

Click on your desired file to select in the Contents List box. If the file list is too long to fit in the box, use the 
scrollbar to move through it. 

Step 5: Select Load button (r. 

o load the design file, click on the Load button. 

Using the most Recent Files list 

The most Recent Files list contains the names of the files that have been opened most recently by AutoStitch. 
The list appears at the bottom of the File menu, just above the Exit menu. A number of files appear under the 
Recent Files Sub-menu. 

Notes. 
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1. If you have just installed AutoStitch, the list will be empty. 

2. You can select a design from the list by clicking on it. 

Using My Computer or Windows Explorer 

If the file's extension is associated with AutoStitch, you can Load the design by double-clicking on it. 
Associated file types use the AutoStitch design icon s 

Using Drag-and-Drop 

You can load design by "dragging" them from My Computer or Windows Explorer and "dropping" them on any 
of the following: 

o AutoStitch's Main window 

o AutoStitch's executable file(.EXE) 

A Shortcut to AutoStitch's executable file 

s Step by step. 
5. The steps shown here walk you through dragging-and-dropping design to the Main window. The access for 

dragging-and dropping to .EXE or a shortcut is essentially the same. 

s Step-by-step instructions 
t -man-man 

Step 1: Position windows s 

o Position the My Computer or Windows Explorer window and AutoStitch Main window so that you can see 
both of them. 

o My Computer or Windows Explorer window should be on top since you will use it to "grab" the file. 

e Only a small part of the AutoStitch Main window, just the Tittlebar, needs to be visible. 

Step 2: Find the design is a 

Find the design in My Computer or the Window Explorer. For further assistance, see the application's 
document. 
Step 3: Grab the design in a 

1. Point at the file with your mouse. 

2. Press and hold the primary mouse button 

topic-20-31 
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Primary mouse button 
On a two-button mouse, the primary button is the one that you use more often. For most users, it is the left 
button. If you are left-hander, your buttons may be reversed, in which case the primary button would be on 
the right. 
t 

Step 4: Drag the design is a 

Drag the design to the AutoStitch Main window by moving your mouse. 

Step 5: Drop the design <s 

You drop the design by releasing the mouse button. The AutoStitch Main window will move to the foreground. 

Using Run dialog box 

You can add design name to the command line after the AutoStitch executable filename in Windows Run 
s dialog bOX. 

Create a Design 

AutoStitch provides four ways to create designs: 

• Creating a new Design by inserting 
• Pasting from the Clipboard 

Notes. 

1. if you are new to AutoStitch, click the New Design button After that you can begin creating a 
new design. i 
2. Once you have performed any operations in the Object View window, clicking the New Design 
button will bring forth the message "Save Change to...?" on the screen. If you want to save those 
operations of the previous design, click Yes. (If you save the new design, the Save AS dialog box will 
be displayed. If the design that you want to save is already the present one, the Save AS dialog box 
will not be displayed and instead the design will be saved directly.) If you want to give up the 
operations of the previous design, click No. If you clicked the New Design button by mistake, click 
Cancel to continue working. 

3. The Object View window can run only one design for a time. If you want to create another new 
design or load another design, you must close and save the current design being worked upon. 

4. When you use the New dialog box for the first time, the Design's folder is the default folder. The 
Design's folder is located under the AutoStitch folder, which is a good place to store designs and 

is databases you are currently working on. 
k 

"topic-32-37 
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Merge Mask into Stitches 

it is necessary to have a sense of unevenness in embroidery, so AutoStitch provides the user with Merge 
Mask into Stitches, which enables the user to create denser stitches in some special areas where you have 
inserted something like letters, curves and areas etc. so as to achieve this effect of unevenness. 

1. Click Generate. 

2. Select Merge Mask into Stitches from the Stitch menu. 

3. The new window will pop up and replace the previous window. 

S. insert Curve To insert one or several curves into areas which are filled with complex fill. 

Insert Closed Curve To insert one or several areas into areas which are filled with complex fill. 

3. insert TrueType Font Border To insert one or several letters into areas which are filled with complex filt. 

Move Bottom To move the present mask that has been selected by left-clicking to the bottom 
among all the masks of the design. 

Move Top To move the present mask that has been selected by left-clicking to the top among all the 
masks of the design. 

Save Mask. To save all the present masks as an AutoStitch Mask File (*.MSK). 

Load Mask Loads existing Mask Files into the present mask window. 

t New Mask Deletes all the masks of the present design and creates a new mask. 

Apply/Exit Exits the mask window. The created mask is saved and applied to the present design. 

s is Exits the mask window. However, the created mask is only saved in the mask window and not applied to 
the present design. You can also press the Esc key to achieve the same effect. 

4. Right-click to select a mask and then press the Spacebarkey. Now, the Mask Area Property dialog box 
will pop-up, and in this dialog box, you can check None, Male, Female, and Split, among the Mask options 
under the General mark according to your requirements. 
O check None: the mask will not be functional. 
o check Male: the mask will become convex. 
a check Female: the mask will become Concave. 

check Split the Split mask will be added in the Mask Area Property dialog box. Select your desired 
split pattern and the masking area will adopt the relevant split pattern. 

lf the selected mask is a single line, you can check None, Male, or Female, among the mask options in the 
pop-up Mask Line Property dialog box according to your requirements. Meanwhile, you can type the relevant 
width value in the Width input box. 

5. You can view the effect you have created by clicking Display Stitch Position or the Quick View and using 
Zoom in. 

Tip. 

The mask that has been selected by left-clicking can be Resized, Rotated, Transfigured, etc. In 
addition, you can modify the properties of the selected mask by right-clicking. 
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Notes. 

1. While using mask, it works only in an area which is filled with Complex fill. 

2. While defining the middle point of a curve or an area, left-clicking shows that the point is one of the 
consecutive; right-clicking shows that the point is a broken point. And these two insertion states can 
be finished by pressing the Enter key and canceled by pressing the Esc key. 

3. Once a mask is merged into the stitches of the present design, the effect of masking can be 
deleted by Undo. You can use New Mask or left-click the mask and then press the Del key to delete 
the effect of masking. if the mask is merged, New Mask can only delete the Superficial mask and the 
created masking effect will still exist. 

4. The differences between and x, the former will merge the mask into the stitches of the present 
Sk design while exiting, but the latter does not merge the mask into the stitch while exiting, 

Creating a new Design by Inserting 

if you want to insert a new object in Object view window, you can: 

1. Select the Sub-menu from the insert menu. 

2. Click proper button in the toolbar. 

AutoStitch provides three ways to insert an object : 

insert a TrueType Font 
Insert an image File 
InSerta Picture From Scanner 
InSerta AutoCAD DXF File 
Insert a Column Area 
inSeria Shape 

Tip. 

Sk You can insert a Second object into an open design. 

Importing a Design 
AutoStitch provides the user with importing a Design which is used to import design or stitch files that have 
been previously done. 

When you haven't closed the design the Import function can import the formerly-created or other Companies' 
Design File (ASD) or Stitch File (.PXP, *.EXP, ".DST, etc.) into the computer so that they overlap upon or lie 
beside the original design. 

age Step by step Instructions 

Vote. 

"topic-40-42 
creating a new design by inserting 

k Creating a new Design by Inserting 
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1. Importing a Design can import a design or stitch file created in another application. Click your 
desired file format in the File Of Type box that lists folders and files. You can also type the extension 
in the File Name box, for example, type *.EXP, to find Melco stitch files. 

2. Importing a Design is different from Loading Design. Load Design can only load Design Files 
("ASD). Even if you select All Flies (".") and see the stitch file, you can not load it; the warning 
message" Not an AutoStitch Design file" will appear. In addition, while using Load Design, if the 
design in the current window has not been saved, "Save change to..." will remind you of it. Therefore, 
you should first close and save the design in the original window, and then load the new design file. 

Sk "import" can import not only Design Files but also Stitch Files through choosing the File Of Type. 

insert a TrueType Font 

if you want to insert several letters from any TrueType Fonts in the ObjectView window, just use insert a True 
Type Font. 

The Text Insert dialog box on the screen will provide you with the options of Style, Size, Color, Content, Bold 
and Italic, of the inserting characters. Then all the operational results will be displayed on the Preview. 

GES Step by step instructions 
mammam-mm 

Step 1: Access Text insert dialog box s 

There are two Ways to access Text insert dialog box 

i is o Click the TrueType Font sub-menu from the Insert menu. 

Click on the Insert Font button s in the toolbar. 

Step 2: input characters is a 

You can input the desired characters including Chinese characters, English letters, symbols, etc. In addition, 
you can also insert a blend of characters and symbols so long as your computer supports them. 

Tips: 

1. The maximum number of characters that are allowed to be input are one hundred. 

2. The characters can be upper case letters, lower case letters, or a mixture of the two. 

Step 3: Select Style is a 

Click on the drop down box of the Style option under Text Property, all the styles that your computer supports 
will now appear in the list. Click on your desired style. If the style is not visible, use the scrollbar to move 
through the list. 

Notes. 

"topic-42-44 
insert a TrueType font 

* Insert a TrueType Font 
"topic-44-45 
"topic-44-46 
topic-44-47 
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1. The default of the style is Arial. After you select a style, this style will become highlighted in the 
Style option. 

2. if your desired style is not visible, click the scrollbar to move through the list. Click Help from the 
Windows Startmenu and then double-click How To \ Change Windows Settings \ Add or Remove 

if Fonts. Then click the icon that represents the detailed information you want. 

Step 4: Select size is a 

Click on the Size option under Text Property. All the available sizes of the font will now appear in the list. 
Select the desired one and click on it. If the size is not visible, use the scrollbar to move through the list. 

Tip. 

1. The allowed range of sizes is 25.40-127.00. 

2. You can enlarge or reduces the object manually after inserting. 

Left click to select the object and then you will see the cursor become double-head arrow. If you drag 
any one of the eight point toward the direction which the arrow outside the frame points to, both the 
frame and the object will become larger. If you drag any one of the eight point toward the direction 
which the arrow inside the frame points to, both the frame and the object will become smaller. 

Notes. 
1. The default of the size is 25.40. After you select any size, this size will become highlighted in the 
Size option. 

2. You can only select sizes which appear in the list - you cannot change or input the size value 
manually. 

Step5. Select color a st 

Click on the Color button under Text Property, and the basic 48-types of colors will now appear on the Screen. 
Select one of them and then click OK. 

Tips: 

1. If you want to save the first defined color, you should begin by selecting a black Column before 
selecting the second defined one. Otherwise, the second one will replace the first one. 

2. AutoStitch provides its users with 16 custom colors at one time. If you go beyond this limit, the 
extra ones will replace original ones. 

Notes. 

1. If you are not satisfied with the basic 48 colors which are offered to you, click the Define Custom 
Colors button. Now, use the mouse to click a desired color on the palette; in the same Column, drag 
the right arrow to alter the shades of available colors. 

2. If you are familiar with mixing colors, input the proper matching value in the columns of Hue, Sat, 
Lum, Red, Green, and Blue. Your desired color will now be made available. 

topic-44-48 
"topic-44-49 
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3. Color/Solid displays the final color. You can choose one of them or double-click the Solid to gain 
the same Color as the Color area. Click on the Add to Custom Colors button. The selected Color will 
now be filled into one of the custom color columns automatically. 

4. Click the custom color column with the color you defined, and then click OK. 

g This way of selecting colors will practicable with all the characters or Symbols in the Content. 

Step 6: Decorate characterss st 

The Bold and ltaic boxes under Text Property offer you two ways of highlighting. If you want to use the two 
options, check one or both of them in the check box and your selections will now be highlighted with a check 
mark. To undo these options, click them again. 

Step 8: Confirm fs 

After highlighting or modifying the selected characters, click OK. The outline of all the characters will now be 
displayed in the Object View window. ' 
Insert an image File 

insert image dialog box on the screen will provide you with all the image files that AutoStitch Supports. 

ge 
GS Sep by step Instructions 

Note. 

The image that you insert should not be too small, otherwise AutoStitch will offer you a warning 
i: message." The image is too small to generate outline". 

Step 1: Access Insert image dialog box st 

There are two Ways to access insert Image dialog box. 

o You can click image File sub-menu from the insert menu. 

You can click on insert image button in the toolbar. 

Step 2: Select file's folder is a 

Using the following controls to select a folder. 

O LOOK In box 
o Up one level button 

Contents List box 

"topic-44-50 
"topic-44-51 
"topic-42-52 
insert an image file 

* Insert an Image File 
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Step 3: Select file type s a. 

You select the file type from the File Of Type. 

1. Click on the drop down box. AutoStitch will open it. 

2. Click on the File Of Type that you want to select. If the file type is not visible, use the scrollbar. 

Note. 

To open an image file created in another application, click the desired file format in the File Of Type 
box. You can also type the extension in the File Name. 

Step 4: Select file 1s a 

Click on your desired file in the contents list box. If the list is too long to fit in the box, use the scrollbar to 
move through it. 

Note: 

t When you first use the Insert image dialog box, the AutoStitch folder is the default folder. 

Step 5: Select insert button (s 

To insert a selected image file, click on the insert button, and then the Image Processing dialog box will pop 
up. 

Tip. 

if you are certain about the content of an image file, double-click the filename directly to insert it. If 
you are not clear about it, click the filename, and then the image file will be displayed in the right 
window, check it. You can click each one of the listed image files. After finding out the desired one, 

Sk click the insert button to insert it. 

insert a Picture From Scanner 

if your Computer is equipped with a scanner and you wish to insert the newly-scanned object into the Object 
View window, Select the Picture From Scanner sub-menu from the Insert menu. 

g Step by step Instructions 

Note: 

The image that you Scan into AutoStitch should not be too small: its width should be not less than 
4cm and its height should be not less than 3cm, and the maximum multiple of enlargement should be 
more than 200. Otherwise AutoStitch will offer you a warning message." The image is too small to 
generate outline". 

"topic-52-56 
"topic-52-57 
"topic-42-58 
insert a picture from scanner 

* Inserta Picture From Scanner 
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Step 1: Activate Scanner st 

There are two ways to activate a scanner in AutoStitch. 

o Select the Picture From Scanner G Sub-menu from the insert menu. 

o Click on the insert From Scanner button in the toolbar. 

Notes. 

1. The warning message "A Twain error occurred" and "error in scanning file” will be displayed on the 
screen if your scanner is not properly connected to your computer or not properly working, Click OK to 
cancel the operation. After that, you should connect your scanner to your computer or re-install the 
scanner's device driver. 

2. If your scanner is properly installed to your computer, the scanner will be activated automatically. 
(The title bar will be highlighted and the window will always be on top.) The title bar of AutoStitch will 
be dim and can not be activated until scanning is completed. 

3. If you want to exit the application without scanning, the warning message "Error in Scanning file" 
will be displayed on the screen. Click OK to cancel the operation. 

Step2: Object Scanning *N 

1. Put the object that you want to scan into the scanner. 

2. Click on Prejudge button. 

3. Adjust the default values of the application in order to get the final desired effect of scanning. 

4. Use the mouse to select your desired parts of the object or the whole object and click the Close button. 
The image Processing dialog box will then pop up. 

Tips: 

1. You can select insert Picture >From Scanner repeatedly. 

2. GRP. bmp under the Temp directory does not stand for any special brnp file. It is only a temporary 
file and does not exist at all. GRP". bmp will appear under the Temp directory when any "ASD file is 
opened. Once the ASD file is closed or deleted, the relevant GRP. bmp will disappear. 

3. if some ASD file contains several images (which have been obtained from scanning or inserting an 
image) the relevant GRP. bmp will appear under the Temp directory. 

4. You can open a GRP".bmp file in certain other applications. 

All the above-mentioned operations will not be executed if the relevant ASD file is closed or deleted. 

Notes. 

1. Once finished scanning, the scanner window will be closed automatically. Meanwhile, AutoStitch 
will be reactivated (the title bar will be re-highlighted). The scanned object will now be inserted and 
displayed. 

2. Once finished scanning, a temporary file, GRP. bmp, will appear automatically in the Temp sub 
directory which is under the AutoStitch directory. All scanned content is stored in this temporary file. 

"topic-58-59 
"topic-58-60 
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3. If the scanning effect is satisfactory, click Save button, and this file will be saved. If not, click New 
button and click No or Close the AutoStitch window. 

4. The image that you get from scanning will not become a corresponding ".. bmp file. 

5. Make sure that image or the image window is large enough for generating stitch. The image 
#Sk should not be enlarged after scanning. 

Inserta AutoCAD DXF File 

Insert AutoCAD DXF dialog box will list all the DXF files that your computer Contains on the Screen. 

ge. by step instructions 
h -m-www 

Step 1: Access insert AutoCADDXF dialog box s 

a Select AutoCAD DXF File g from the linsert menu 
i 

Step 2: Select file's folder (s a 
O Look in box 
O Up One level button 

Contents List box 

Step 3: Select file type (s s 
Select the file type from the File Of Type. 

1. Click on the drop down box, AutoStitch will open it. 

2. Click on the File Of Type that you want to select. If the file type is not visible, use the Scrollbar. 

Note: 

To open a CAD file created with a different application, click your desired file format in the File Of 
Type box. You can also type the extension in the File Name input box. 

Step 4: Select file -(N. p. 

Click on your desired file in the contents list box, if the list is too long to fit in the box, use the scrollbar to 
move through it. 

Note: 

"topic-42-61 
inserta autocad dxf file 
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When you use the insert AutoCAD dialog box for the first time, AutoStitch folder is the default folder. 

Step 5: Select Open button (s 

To insert your selected CAD file, click on the Open button, the CAD file will now be displayed in the Object 
View window. 
#Sk 

Insert a Shape 

insert a shape is another insert function that AutoStitch provides you to insert several shapes, such as a line, 
area, solid rectangle, Solid ellipse, and so on. 

1. Select insert menu. 

2. Click proper sub-menu from Shape. 

Inset a Line 
Insert an Area 
InSert a Rectangle 
Insert an Ellipse 

SK 

Merge 

AutoStitch provides the user with Merge according to users' different requirements, which can merge not only 
several areas of the same or different colors into a new area but also several lines of the same or different 
Colors into a new object. 

: 
s o Merge Areas 
; P. Merge Lines 

Sk 

Pasting from Clipboard 

When you paste a new image from Clipboard, AutoStitch loads the clipboard image in the ObjectView 
window. To paste as a new image, you can: 

O Select Paste s from the Edit menu 

a Click Paste s button in the toolbar, or 

o PreSS <CTRL>+CV2. 

File format converters supplied with AutoStitch' 
"topic-61-66 
"topic-42-67 
insert a shape 

* Insert a Shape 
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K Merge 
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AutoStitch provides file format converters for the applications listed in the following table. 

File converters supplied with AutoStitch 

File format Comments 

Insert a second object into an open Design 

On Insert menu, click your desired file type. 

Insert a TrueType Font 
insert an image File 
Insert a Picture from a Scanner 
InSerta AutoCADDXF Fie 
Insert a Column Area 

Sk Insert a Shape 

Split Stitches s 
Split Stitches enables you to split a string of stitches into two strings of stitches which a defined needle point 
lies in. The string of stitches before and after this point form two areas respectively, so split Stitches can split 
not only a string of stitches but also an area. 

1. Generate the object. 

2. Click the Edit Mode button and the Display Stitch Position button on the toolbar. 

3. Left-click the needle point at which you want to split the string of stitches, and then you will See a red CrOSS 
cursor located at this point. 

4. Select Spiit Stitches from the Stitch menu. Now the stitches were splited. 

Tip: 

You can only split a string of stitches one area at a time. If you want to split a string of stitches into 
several strings of stitches, you must repeat the operation. 

Notes. 

1. The selected area must have been generated, and the operation should be under Edit Mode. 

2. After Split Stitches, the running direction of the stitches is not changed, though the string of 
stitches is split into two strings of stitches. 

3. After Split Stitches, the string of stitches before and after the split point form two new areas 
isk respectively, and the stitches within the two areas are consecutive. 

topic-71 
topic-72 
split Stitches 
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Troubleshoot Loading Designs 

What do you need help with? 

• The Load dialog box does not list the design I am looking for 
The passWord l type to load a design does not Work 

The Load dialog box does not list the design I am looking for 

o Check in the Load dialog box, make sure that you are typing the correct name of the design in the File 
Name box. 

a Make sure that you have the correct design format (ASD) selected in the File Of Type box. 

Make sure that you are looking in the correct drive and in the correct folder. 

The password typed to load a design does not Work 

Passwords are case sensitive. Check to see whether CAPS Lock is turned on, or retype the password to 
make sure that you have not mistype it. 

Step 7: Change the Layout (s a 

Click the Layout button which is on the right of the Content input box and define the baseline for the inserting 
true type fonts. 

in the pop-up Layout window, choose a sort of baseline in the baseline dropdown box. If you want to choose 
one baseline outside Anyshape, you need to offer related length, angle or radius. 

Click anyone button under Direction to ensure the true type fonts to be arranged along the baseline. 

Tip. 
To change these true type fonts or the position of one of them along the baseline, you can use Text 
Layout under the Edit menu. 

N.Ofe. 

After selecting Anyshape in the Baseline dropdown box and clicking OK, the users need to define the 
shape of the baseline by themselves. Left-clicking creates the corner point and right-clicking Create 
the smooth point of the baseline. Having finished defining, press Esc key to exit the state of defining 
baseline. Now the ready-for-inserting characters will be arranged according to the given baseline. 

iSK 

Text Layout 

Troubleshoot Loading designs 
"topic-73-74 
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To modify the position of some texts which have been arranged along certain baseline, you can use Text 
Layout to realize it. 

1. Left-click the object that you've applied Text Layout, and then left-click this object again or click the Text 
Layout button in the toolbar, the text layout editing state will be carried out automatically. At that time, all the 
accessible baselines of all the type texts will be displayed in the current Object View window, and the base 
point with which each type text intersect with its baseline will be displayed with green color. 

2. Left-click to drag the red triangle mark around the baseline so as to change the shape of the baseline. 

3. Left-click to drag the red triangle mark around the shadow frame so as to change the height of all the text 
arranged along the current baseline. 

4. Left-click the base point of the type text that you are going to alter its position so that it becomes red. 
Move the cursor to this red point and hold down the left mouse button to move it, now the type text will move 
along the baseline in the direction toward which you are dragging to alter its position on the baseline. 

5. To change the position of all the type texts on a baseline, you may first left-click anyone base point on the 
baseline, and then hold down Ctrl key move the cursor to point to the red point, and hold down the left button 
to move it. Now you will See all the type texts on the baseline will move in the direction that you are dragging 
toward. 

is 6. Left-click the button A in the right side of the shadow frame to re-enter insert Text dialog box and reset 
every options. Now you'll find the options which belongs originally to Layout dialog box have been placed in 
insert Text dialog box. 

7. Right-click to finish the operation. The modifications are canceled the moment that you press the Esc key 
to exit the modify state. 

8. Click Generate. 

Notes. 

1. To enterText Layout editing state, first select Layout button while inserting texts, and then left-click 
the object that you've applied layout twice after inserting texts. 

2. If the type of the baseline is Any type in the Layout, AutoStitch will not provides the function of 
changing the shape of the baseline after entering Text Layout editing state. 

3. Hold down Ctrl key and then left-click several basepoints along the baseline one by one so that 
they become red. Now if you drag one of the red basepoints, all the texts in which have red 
basepoints will move as a whole along the current baseline. 

Saving a Design step by step 

To save any changes to the active design, you can: 

e Select Save Design from File menu. 

O Click on Save Design button in the toolbar. 

186: Step-by-step instructions 

Note. 

If you are saving a new file, AutoStitch will open Save As dialog box. 

"topic-77-78 
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Step 1: Select or Create file's folder g 

Selecting a folder 

Using the following controls to select a folder. 

a Save In box 
O Up One Level button 
e Contents List box 

Creating a folder 

1. Select the folder that contains the new folder. See the above section. 

fi. Click On the Create New Folder button. 

Creating a new folder 

To add a folder to the currently-selected folder: 

1. Click on Create New Folder button. AutoStitch will add a "new folder" item to the Contents List box. 
- 2. Type a name for the new folder. You can edit the name as you would do to any other text. 

3. Press<Enter. AutoStitch will create the new folder, add it to the Contents List box, and highlighted it. 

s 4. Press <Enters again. AutoStitch will open the new folder. 

is Save in box 
Save in box lists the currently-selected folder and any folders above it, including the Windows system folders 
(Desktop, My Computer, etc.). To select a folder: 

1. Click on the drop down box to open it. 

2. Click on your desired folder to select it. If the folder is not visible, use the scrollbar to move through the list. 

Contents List box 

Contents List box displays the contents of the folder that is currently-selected in the Save in box. To select a 
folder. 

1. Click on your desired folder to select it. If the folder is not visible, use the scrolibar to move through the list. 

2. Click on the Save button. AutoStitch will update the Save in box and the Contents List box. 

Step 2: Select File Type its a 

Select file type from the File Of Type box. 

"topic-78-79 
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1. Click on the drop down box to open it. 

2. Click on your desired file type ("ASD) to select it. If the file type is not visible, use the scrollbar to move 
through the list. 

Step 3: Enter design name -(q p 

Enter a name for the new design in the FileName Text box. Don't worry about the file extension, AutoStitch 
will add it automatically. 

1. Double-click in the text box. 

2. Type the file name in it. 

Step 4: Select Save button s 

Click on Save button. One of two possibilities will happen: 

e AutoStitch will save the design and close Save As dialog box. 

o You will be asked if you want to replace an existing design. 

e Click on the Yes button to replace it. 

SK e Click on the No button to leave the design intact and return to Save AS dialog box. 

Frame/Original Point 

in embroidery, a frame is usually needed to be installed on the cloth beforehand. If the user also wants to 
install such a form, use Frame/Original Point. In addition, if you need to define the position of the original 
point while stitching in advance, you can also use Frame/Original Point, 

1. Select Frame/Original Point from View menu. 
2. To employ a frame, you can choose one frame type in the Frame type dropdown box which is in the pop 
up Frame/Original Point dialog box. In addition, you can modify the frame according to your requirements, for 
instance the length, the height and the radius. To display the frame in the ObjectView window, check Show 
Frame checkbox. 

3. To define the position of the original point, type your desired values in X and Y input box under Original 
Point in the pop-up Frame Original Point dialog box. To display the mark of the original point in the Object 
View window, check Show. Original point checkbox. 

Tip: 
To define the original point, you can do it not only through inputting values in the dialog box but also 
through directly dragging its mark. 
Point the Cursor to the mark of the original point, the cursor will become a moveable mark. Hold down 
the left button, the original red cross become a XIY axis, and then hold down the left button to move 
the cursor. Thus, the mark of defining the original point will move a little bit along the X and Y 
direction so as to redefine the original point. 
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SK 

Switch to Simple Mode/Professional Mode 

To meet the different requirements of each user, AutoStitch provides two mode: Simple Mode and 
Professional Mode. The user can switch between the two modes simply by clicking Switch to 
Simple/Professional Mode from View menu in each mode. 

in Simple Mode, AutoStitch provides the user with a series of basic operation functions. The user can perform 
various operations on the files and database, but only simple operations such as editing, Setting, viewing, etc. 
are allowed to be done to the current design. The series of operations about the outline, block and stitches of 
the current design are not allowed. 

in Professional Mode, AutoStitch provides the user with some powerful and convenient functions on the basis 
of some basic functions. The user can use not only all the functions offered in Simple Mode but also the 
editing, settings and viewing to do some high-leveloperations on the current design. In addition, the user can 
perform various flexible editing operations to the outline, block and stitches of the current design so as to 
perfect the design. 
isk 

Adding a Design into DataBase 

Add into Database enables the user to add ASD or .PXP files in the present Object View window into an 
appointed Database. 

2. In the pop-up database dialog box: 
o The information option is used to display relevant information about the present ASD or PXP file. It 
will be displayed only after the present ASD or PXP file has been generated. In the Classification drop 
down box, you can input your designated classification name. 

o The Database option is used to designate the database that the present ASD or PXP file will be added 
into. 

(1) if this database is an existing one, you can type the whole path and database name directly into 
the Add input box or click the Select button in the Open dialog box and select this database. 
(2) If this database is not an existing one, click the New button in the pop-up New Database dialog 
box and type the new database name into the Database name input box and the location of the new 
database in the Location input box or click the right-side button g and select the drive and path of 
this new database in the pop-up Choose Directory dialog box. 

s Some options in the lower part of the dialog box are used to designate the filename, file type, and path 
of the Design in this created or selected database. 

Click OK. 

Notes. 

1. When you use New to create a new database, you can only define a classification name by typing. 
When you use Select to select an existing database, you can define a classification name not only by 
typing but also by Selecting one in the Classification name list. 
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2. While typing any character in File name, if the present design has been saved, the name of the 
design, its location, and file type, will be displayed in File name, Location, and Files of type, if it has 
not been saved, its file name will be named as Untitled and its location is the present AutoStitch. 

3. If you use File of Type to designate the file type, a design can have ASD or PXP. 

4. Using Windows Explorer, you will find the created database is in the designated path and an index 
file.idx (you can't delete this idx file while the relevant SLB exists.) of the same filename will be 
created at the same time. You can use Lib Manager under the AutoStitch directory to open this 
database, and now you will find your designated design has already been saved in it, and its relevant 
properties are the same with those you have designated. 

5. PXP can not be saved as ASD, but ASD can be saved as PXP. 

Exporting a Design 

You can transform the current design into a Stitch File (.PXP, *.EXP, *. DST, etc.) by using the Export 
function. 

g Step-by-step instructions 

Notes. 

s 

al 
as: 

1. You can import a design or a stitch file created in another application, work on it in AutoStitch, and 
then save it in its original format. For example, you can import a Melco stitch file (".EXP), edit it in 
AutoStitch, and then save it in either AutoStitch or Melco stitch file format. 

2. Although both "Save Design" and "Export" are supported to save the design in AutoStitch; "Save 
Design" saves the design as a Design File while "Export" saves the design as a Stitch File. 

3. After using Export, the objects in the original design will be grouped together into a new group 
while transforming it into a stitch file. 

Sk 

: Printing a Design 
1. Select Print Sample g from the File menu. 

2. To specify the portion of the design you want to print, click an Option under Page Range. If you click 
Pages, you must also input your desired page numbers or page ranges. Print the active design from the Print 
dialog box. 

N 
f -a- 

Step 1: Before Printing the Designs 

Before printing the design you can setup your current printer firstly. Select 
Print Setup from File menu. Its settings determine the paper source, paper size, properties and etc. 

"topic-77-89 
exporting a design 

* Exporting a Design 
"topic-77-90 
printing a Design 

* Printing a Design 
"topic-90-91 

27 

  

  



US 2002/0183886 A1 Dec. 5, 2002 
34 

Print Setup 

Step 1: Access Print Setup dialog box or 

Print Setup settings determine the paper source, paper size, properties, and choose the type of your Current 
printer. You can change the print setup from the Print Setup dialog box 

You can access the dialog box by: 

o Selecting "Print Setup" from the File menu. 

Step 2: Select printer ty p 

Click a Name under Printer. 

o Use drop down box to choose the printer. 

To set printer-specific options, click on the Properties button. 

tep 3: Select Paper Size and Source (s s 

ou can select paper size and source from the drop down boxes in the paper group box. 

For some printers, one or both of the drop down boxes may be unavailable. 

tep 4: Set Page Orientation -s a 

There are two page orientations, portrait and landscape. 

o Printing in portrait orientation places the top of the design against one of the page's narrow sides. 

o Printing in landscape orientation places the top of the design againstone of the page's wide sides. 

To select an orientation, click on its text or option button in the Orientation Group box. 

Step 5: Select OK button (r. 

Click on OK button. AutoStitch will close Print Setup dialog box and save the new settings. 

Step 2: Access Print dialog box its at 
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You can select Print Sample from File menu. 

Step 3: Select Printer <s a 

You can select printer from Printer drop down box. The drop down box lists all of the output devices that are 
available to your system. For example, in addition to the available printers, it will also include any fax Software 
that is installed on your computer, 

1. Click on the drop down box to open it. 

2. Click on your desired printer to select. If the list is too long to fit in the box, use the Scrollbar to move 
through it. 
h 

Step 4: Set Printer Properties (Optional) is a 

if you want to change the selected printer's properties, click on the Properties button. AutoStitch will open 
properties dialog box for the selected printer. For help, using the dialog box, and try pressing <F1>. 

Step 5: Set the Print to File checkbox is st 

The Print To File checkbox determines if the output is sent to the selected printer or to a printer file. If you 
Want to... 

Send the output to the selected printer, make sure that the checkbox is empty. 

Send the output to a print file, mark the checkbox. You will be prompted for the filename later. You can 
then print this design at a later time. 

- Step 6: Enter the Number Of Copies is a 
if your printer supports multiple copies, you can print more than one copy of a design at a time. If your printer 
does not support multiple copies, the Number Of Copies spin control will be grayed out. 

o You can type the number of copies into the spin control, or you can use arrow buttons to set the value. 

o To scroll to a higher or lower value, point at the appropriate button and press and hold the primary mouse 
button. 

t 

Step 7: Select OK button (r. 

When you are ready to print, click on OK button. One of two possibilities will happen, depending on the 
setting of the Print To File checkbox: 

o if the option is off, AutoStitch will send the design to the printer. 

s if the option is on, AutoStitch will open the Print To File dialog box. For more help, press<F1>. 
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Saving a Design 

o You can save the active design by clicking 
o You can save a copy of the active design with a different name or in a different location. 

What do volt want to do? 

o Save an existing Design 
Save a new, unnamed Design 
Save another Copy of a Design 
Save a Design that was created in another application 
Save a Design automatically as I WOrk 

f 

Save Design button (Main Tool Bar) 

Save the active design file with its current file name, location, and file format. 

Save an existing Design 

I To save the changes to the active design, you can: 

O Select Save Design from the File menu. 

o Click on Save Design button in the toolbar. 

Save a new, unnamed Design 

1. Click 
2. To save the design in a location other than the AutoStitch folder, click a different drive name or folder 
fare. 

To save the design in a new folder, click s 

3. In the FileName box, type a name for the design. You can use long, descriptive filenames if you want. 

4. For information about naming files in AutoStitch, click Save. 
if 

Io get more information by step, Sé. 

Naming files 
To make it easier to find your files, you can use long, descriptive filenames. The complete path to the file, 
including drive letter, server name, folder path, and filename, can contain up to 255 characters. File names 
cannot include any of the following characters: forward slash (f), backslash (\), greater-than sign ( > ), less 
than sign (<), asterisk (*), question mark (?), quotation mark ("), pipe symbol ( ), colon (:), or semicolon ( 

). 

Saving a Design 
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Save another copy of a Design 

Use Save Design. As to save a design for the first time, or to change the name?location of a design or to save 
the current design with a password. Save Design As allows the design to be saved as a format. To use Save 
Design As: 

1. On File menu, click Save Design As. 

2. In the FileName box, type a new name for the design. You may name your design anything you wish as 
long as the name is not more than eight characters long, and with a three letter extension. 

3. Select your desired type to save the design as. 

4. Click on your desired directory to keep the design in. 

5. Click on Save to save the design. 

Tip: 

To save the copy in a different location, click a different drive name or folder name. To save the Copy 
s: 

is #SK in a new folder, click C. 

: Merge 3D Wrap 
To merge a defined wrap into the activated motif fitt area, the user can employ AutoStitch's Merge 3D Wrap. 

1. Right-click to activate an area, and then click Properties button in the toolbar or press the Space bar. 
2. In General tab, click Motif Fill stitch type. If motif fill does not appear, drag the scroll bar to make it visible. 

3. Click the newly-joined Motif Fill tab and make proper settings for the Motif which is ready to join the current 
aea. 

4. Click Generate. 

5. Select Merge 3D Wrap from Stitch menu. 

6. In the pop-up Select3D Wrap dialog box, choose a wrap type. if your desired type is not visible, drag the 
scroll bar to make it visible. If it remains invisible, the user need to edit one in the 3D Wrap Model Editor. 

7. After clicking OK, the user will enter Merge 3D Wrap window automatically, and the wrap type that you 
have just selected will appear in it. Dragging anyone of the eight points around the wrap by holding down the 
left button can change the size of the wrap. Click the wrap once more and point the cursor to anyone of the 
four rotating marks, the wrap will be rotated in response to it. 

8. Having finished these elementary editing operations, move it by holding down the left button to the motif fill 
area and make them overlap each other completely. 

: Click it to save the current modifications of the wrap as 3D Wrap data file and enter its file name in the 
pop-up Save AS dialog box. 

"topic-103-108 
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Click it and then point the cursor to a point within the wrap and drag it, the height of this point will be 
altered. (for example, convex or concave) 

s: Click to exit the Merge 3D wrap window. The created wrap is saved and applied to the present 
design. 

Tip: 

After Merge 3D Wrap, you can click Quick View button to view the effect. 

Notes. 

1. Merge 3D Wrap is valid only when the area is activated motif fill area. 

2. Only one wrap can be selected at one time while merging 3D wrap. 

3. While defining the height of a point within the wrap, i.e. Modify Height Definitions of the Wrap 
button is checked, you can not resize or rotate the current wrap. 

i 

Save a Design that has been created in another application 

1. On File menu, click Save Design AS. 

2. In the File Name box, type a new name for the design. 

3. In the Save As Type box, click the format in which you want to save the file. 

4. Click Save. 

as Save a Design automatically as work 

1. On View menu, click Interface Preference. 

2. Check Auto-Save Design check box. 

3. In the Minutes box, double-click it and input the interval at which you want AutoStitch to save the design. 

4. When you finish working on the design, click to save it. 

Note: 

The automatically saved Design is saved in a special format and location until you save them. When 
you restart AutoStitch after a power failure or other problems that occurred before you saved your 

FSk operations, AutoStitch will open automatically. 

Insert a Rectangle 

If you want to insert a solid rectangle, you can: 
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1. Select insert menu, and then click Rectangle - from the Shape sub-menu or click Insert Rectangle button 
in the toolbar. 

2. Now the cursor will become a pencil with a plus. Left-click to define any one corner of the rectangle, drag 
the mouse and hold down the Ctrl key without releasing it. When you think the size of the inserting rectangle 
is Ok, left-click to finish this operation. 

3. Click Generate $. 

Tip: 

To insert Solid souare, drag the mouse without holding down the Ctrl key. 

Note: 

Sk Right-click or press Esc key to cancel this operation. 

insert an Ellipse 

if you want to insert a solid ellipse, you can: 

1. Select insert menu, and then click Ellipse O from the Shape sub-menu or click insert Circle(Ellipse) in 
the toolbar. 

2. Now the cursor will become a pencil with a plus. Left-click to define any one point of the circumference, 
drag the mouse and hold down the Ctrl key without releasing it. When you think the size of the ellipse is Ok, 
left-click to finish this operation. 

2. 3. Click Generate 3. 

Tip: 

To insert solid circle, drag the mouse without holding down the Ctrl key. 

Note: 

Sk Right-click or press Esc to cancel this operation. 

Working folder 
The folder in which your files will appear while using either Load or Save As command (File menu). If you 
Select another folder while loading or saving an image file, that location becomes the working folder. You can 
specify a Working folder if you load or save files by using a particular folder. 

Model Copy 
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AutoStitch provides the user with a new way to copy, called Model Copy. It can not only copy the originally 
selected area, but can also enlarge or reduce it in proportion, or copy it after being rotated a certain number of 
degrees. 

1. Insert an image or Some characters into the Object View window. 

2. Right click or drag a frame by holding down the right button to select one or several areas. 

3. Select Model Copy from e the Edit menu or click Model Copy de in the toolbar. Now you will find the 
original cursor becomes a pencil with a plus. 

4. Left-click twice to Create two points in the ObjectView window, and the two points can be positioned inside 
or outside the selected area. Now you will find the original black line becomes a green line, which has its own 
direction and length. We define it as Reference Line. 

5. Left-click twice to Create two points in other space within the Object View window, and the line segment 
formed by the two points also has its own direction and length. This line and the Reference Line perhaps are 
different in length and rotating angle. After clicking, you will find the original black line disappears, and a 
Copied area is created there. The Scale between the new area and the original one in size is equal to the 
scale between this line and the Reference Line in length. The number of degrees which the copied area has 
rotated in reference to the original area is equal to that of the original two drawn lines. 

6. Right click to exit Model Copy. You will find the cursor resumes its original shape. 

Tip. 

After model-Copying you will find the newly created units grouped together automatically. 

Votes. 

1. As long as you do not right-click, many line segments can be created and they will model-copy 
many selected areas according to the Reference Line. 

2. While model-copying, the position, size, etc., of the originally-selected area remains unchanged, 
and meanwhile, Some new areas of different size and position are created according to certain 
requirements. 

3. While model-Copying, you must right-click to select one or several areas. Model-copy will not work 
on objects that you select by left-clicking. 

Sk 

Prevent losing work and recover lost Design 
You can protect your work by saving a temporary copy of a design periodically as you work. To be able to 
recover Work after a power failure or other problem has occurred, you must have previously selected the Auto 
Save Design. 

What clovolt want to do? 
O Save a Design automatically as f work 
. Recover a Design that was saved automatically 
Sk 

Ouick View 
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AutoStitch provides the user with Quick View which enables the user to preview the design cquickly. The effect 
that you view in the Quick View window is the very effect after embroidery, that is, what you see is what you 
get. 

1. Generate the object. 

2. SelectView menu, and then click Quick View $from the Simulate View sub-menu or click the Quick View 
buttons on the toolbar. You will now see the effect that you can get out of the embroidery machine later. 

3. Click mouse or press any key to cancel this state. 

Note: 

Before using the Quick View button, you must generate the object and switch it to the Stitch View, 
isk otherwise it can not be displayed. 

Recover a Design that was saved automatically 

to be able to recover work you lost as a result of a power failure or other problem, you must have previously 
Selected the Auto-Save Design check box. 

1. Restart AutoStitch. 

Design that was open at the time of the problem is displayed. 

2. When you see a message asking whether you want to replace the existing file, click Yes. 

Snly changes you made after the last automatic save are lost. 

Create Linelike Area(s) from Line(s) 

inelike Area(s) from Line(s) enables the user to create a relatively closed line-like an area through one or 
Several defined lines. 

1. Right-click or drag with the right button to select one or several lines. 

2. Click Outline menu, and then select Linelike Area(s) from Line(s) from the Create sub-menu. 

3. Input the width of the would-be line like area into Area Width in the pop-up Convert Line to linear area 
window. The default value is 2 mm, i.e. the distance between the selected line and the border of the created 
linelike area is 2 mm. Thus, the width of the whole linelike area is 4 mm. 

Notes. 

1. You can perform this operation only when you right-click to select line(s) and the menu becomes 
highlighted. 

2. You can perform this operation on one or several lines at the same time. 
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3. Having finished this operation, the created inelike area will be activated automatically, and 
becomes an independent area. The originally-selected line and the created linelike area belong to 

Sk different groups. 

Create Area's Border from Lines 

Area's Border from Lines enables the user to create a relatively closed area's border through one or several 
defined lines. 

1. Right-click or drag with the right button to select one or several lines. 

2. Click the Outline menu, and then select Area's Border from Lines from the Create Sub-menu. 

Notes 

1. You can perform this operation only when you right-click to select line(s) and the menu becomes 
highlighted. 

2. You can perform this operation on one or several lines at the same time. 

3. Having finished this operation, the created area's border will be activated automatically and 
becomes an independent area. The originally-selected line and the Created area's border belong to 
different group. 

4. The line that you use to create an area's border can be either a closed or an open Curve. The 
former can create an area's border directly, but the latter can create it after the starting and the ending 

#SK points are linked automatically. A straight line can not create an area's border. 

3D Wrap Manager 

AutoStitch provides the user with several Editors. 3D Wrap Manager is one of them with many powerful 
functions. The user can edit 3D wrap freely in 3D Wrap Manager so that they can be employed in some motif 
fill areas of the design. 

1. Select 3D Wrap Manager from Accessories menu. 

2. In Wrap Editor window, you can choose the offered wrap type in the left list box to modify and also you can 
Create another wrap type by yourself. 

3. Drag the cursor and position it between Smooth and Sharp so as to define the degree of smoothness of 
the current wrap which is closely related to the height of those different points in the wrap. 

4. While editing wrap, click Quick View in dialog box to get a simulate view. 

O modify an existing wrap type 

(1) Left-click the name of the wrap type in the list box, and the right window will display the wrap. 
(2) If the current wrap is displayed together with some blue points and anyone of these blue points will 
present its height when the cursor points to it, that means the current wrap can be modified. 
Double-clicking the point with its height, and type the related height of this point. Omeans the wrap is 
horizontally, negative value concave and positive value convex. To cance this modification, press Esc key. 
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(3) To save the modifications of the current wrap, click save. In the pop-up Save AS dialog box, if the wrap 
name that you have just typed in is the same with an existing wrap, the shape of the newly-modified wrap will 
replace the original one. If you type in a new name, it is equal to create a new wrap. 

o Create a new wrap type 

(1) click New, and in the pop-up New Wrap dialog box choose one type of wrap control points so as to define 
the number of control points in each column and row within the newly-created wrap. 
(2) In the New Wrap's name input box, type in the name of the new wrap. It is also ok to type it in when you 
save it in the end. Our advice for the user is to name the newly-created wrap with a graphic name and it is 
better that this name is different from any existing wrap's name, otherwise, the new one will replace thew old 
Ore. 

Tip. 

The use of wrap type: 
(1) Right-click to activate a motif fill area. 
(2) Select Merge 3D Wrap from Stitch menu. 

#Sk (3) Choose one wrap type among the existing ones and merge it into the current motif fill area. 

Troubleshoot saving and closing Design 

What do vou need help with? 

The file format in which I want to Save a Design does not appear in the Save AS Type 
- 

The file format in which I want to save a Design does not 
appear in the Save AS Type box 

s 

o Make sure that your desired file format is included with AutoStitch. 

o if the file format is included with AutoStitch, install the necessary format converter that you need. For 

more information, click 
h 

Install or remove individual components of Microsoft Office 

1. Close all the open applications. 

2. If the Office Shortcut Bar is available, click the area with the small button at the extreme left or top of the 
Office Short Bar, and then click Add/Remove Programs. If the Office Shortcut Bar is unavailable, point to 
Settings on the Windows Startmenu, and then click Control Panel. Double-click Add/Remove Programs, and 
then click the Install/Uninstall tab. Click Office application, and then click Add/Remove. 

3. Follow the instructions on the screen. 

Notes. 
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1. If you installed the application originally from a network file server or a shared folder, run that copy 
of the Setup program. 

2. To add or remove components of Office on Windows NT, start Office Setup is the same as you 
iSK first install Office, and follow the instructions on the screen. 

Redo Command 

The Redo Command allows the user to easily recover from undo during editing. The Redo feature allows the 
user to undo an undo. 

o if you find your undo operation wrong, select Redo from the Edit menu or you can also click the Redo 
button. 

e You can redo several previous undo operations by repeatedly clicking this button. 

Tips: 

1. In this version you can redo actions at one time: 
Click the artow next to S. to view a list of the most recent actions you can redo. Select the 

action you want to redo. If you do not see the action, scroll through the list. Drag the mouse to 
include all the actions you want to redo or click the last action of the series actions you want to redo. 
When you redo the last action, you also redo all actions above it in the list. 

2. If you later decide you didn't want to undo an undo, click a. 

Note: 

The Redo menu items/button become dimmed when they are unable to be run. 

Redo 

Redo command reserves the last undo to the active object. It can restore the last steps of previous undo 
operations. To use the Redo command, you can: 

e Select Redo from the Edit menu, or 
3. 

o Click on the Redo button S in the toolbar, or 

o PreSS <Ctrld + <Y>. 

Preview the contents and properties 

1. On File menu, click Load Design V. 

2. In Look in box, click the drive and the folder that contains the design you want to view. 

3. in the large box, click your desired design. 
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f To view such details as design size and date last modified, click is 

Image Processing dialog box 

After clicking insert to insert an image file or clicking Close to insert a picture from Scanner, the Image 
Processing dialog box will pop up. This dialog box provides the users with some options for the Settings of the 
inserted image. 

g Step-by-step Instructions 
PW-awww-ror------ 

Step 1: Choose image Types 

It offers you two Image Types: Cartoon and Scanned. The default state is the highlighted one of the two types 
determined through auto-judgement. Usually, the user doesn't need to alter the default option. In addition, 
he inserted image will be displayed and refreshed in the right-side small window. 

Step 2: Set the Maximum Color Number (fs a 

Under the default state, Auto-Judge is checked automatically. That is to say, it judges the number of Colors 
automatically according to the inserted image, and at this moment, the input box which is under it is dimmed. 

Tips: 

1. if you want to reduce the number of colors on some special occasions, you can uncheck Auto 
judge check box and then type in your desired number of colors in the input box. To use several 
colors in the image, click Pick Color. In the pop-up image Manager dialog box, click to select your 
desired color. Click OK, and then type in the number of colors in the left-side input box. 

2. If you wish to define the number of colors by yourself, left-click the Auto-Judge checkbox to 
uncheck it, and then an input box becomes highlighted. The default number of colors is 10, but you 
can double-click that input box to type a new value to alter the default value. For instance, if the value 
you type is 5, the number of colors will be reduced to 5 by neglecting similar colors automatically 
while generating the object. 

Nofes. 

1. If you only type in a value in the input box, the applied colors are defined according to similar color 
after generating. If you pick color and then type in a related value, your defined colors will be 
employed after generating. If you did not type in a related value after picking color, it is equal to use 
Auto-judge and the number of colors are not reduced after generating. 

2. The range of values allowable in the input box is 2-256. If your input value is more than 256 or 
less than 2, AutoStitch will offer you the warning message "Please enter an integer between 2 and 
256." 

i 

Step 3: Define Background (re st 
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Define Background provides you with two options which determine whether there are stitches in the 
background or not. 

The default state is Auto-judge background color. That is to say, it judges the color of the background 
automatically. There is no stitch in the framed background, but there are stitches in the unframed background 
which has the same Color with the background. At this moment, the right-side color button is dimmed. 

Tip. 

The user can define a new color as the background color. Left-click the Auto-Judge background color 
checkbox to uncheck it. Now the Color button becomes highlighted. Then left-click the Omit all 
regions of background checkbox to check it. Now, click the Color button and select a color from the 
pop-up Color window to be the background color. 

Notes. 

1. Once you select Omit all regions of background checkbox, and the selected color is the same with 
Some area or several areas, there are no stitch in these areas which have the same Color with the 
background after generating. if the selected color is different from all the colors of the object, there 
are stitches throughout the object where it is needed. 

2. When both Omit all regions of background and Auto-judge background Color checkboxes are not 
checked, and you appoint a new color in the Color window, there are stitches throughout the object 
where it is needed after generating, no matter whether the newly-appointed color is different or not 

h with some area or several areas of the object. 

Step 4: Adjust image Color Similarity (s a 

In an object, when the boundary of an area is very smooth (there are different colors on both sides of this 
boundary, and the color of the boundary is a transitional one), you can drag the pointer of the image Color 
Similarity toward Distinguish. If the boundary of an area is very crude and sensitive, you should drag the 
pointer of the image Color Similarity toward Similarity. The default state of the Image Color Similarity is that 
the pointer lies in middle point of Distinguish and Similarity. 

Step 5: Adjust Image Noise Level is a 

Generally speaking, when inserting an image directly or scanning a picture into AutoStitch, the Computer may 
Create a certain degree of noise. For this reason, AutoStitch provides the user with Image Noise Level to 
adjust the embroidery effect so as to get an optimum design. 

You can designate the diameter of those areas that you want to ignore by dragging the pointer of the image 
Noise Level. The nearer the pointer is to Noisy, the larger the diameter that you want to ignore. The nearer 
the pointer is to Clear, the smaller the diameter that you want to ignore. in short, the diameter of those areas 
that you want to ignore is always less than your defined value. 

Step 8: Confirm ty 

After finishing the above-mentioned series of operations, click OK to start inserting according to 
requirements. 

If you click OK directly without changing any options, it will insert an image according to its default values. 
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Insert a Line 

The user can use insert a Line to insert a broken line, smooth curve, line segment of a blend of the two, and 
regional boundary lines. 

1. Click Insert menu, and then select Line 3. from the Shape sub-menu or click Insert Line $ in the toolbar. 

2. The cursor becomes a pencil with a plus. Move the cursor to your desired position, right or left click to 
determine the starting point of the inserting line. Again move the cursor to the proper position, and right or left 
click to determine the broken points or consecutive points of the line segment or the regional boundary line ... 
click repeatedly until you press the Enter key to stop the insert operation. 

Tips: 

1. Once you select Insert a line, the insert operation will be started, and will last until you press the 
Enter key. However, you can cancel the operation at any time by pressing the ESC key. 

2. if the inserted line segment or regional boundary line is unsatisfactory, left-click to select it and 
press the Del key to delete it. Also, you can right-click to select it and modify it in many ways. 

3. You can use insert a Line to draw a regional boundary of an area as long as you link the start point 
and the endpoint. But, this operation is different from insert an area. 

4. Each newly inserted object is an independent group. 

Notes. 

1. While inserting line segments or regional boundary lines, if the middle point of these lines are all 
created by right-clicking, they are called turning points. If all created by left-clicking, they are 
consecutive ones. Of course, you can create these points sometimes by left-clicking and sometimes 
by right-clicking, and the line segments or boundary lines will be a mixture of broken lines and smooth 
CUWeS. 

2. While inserting a line segment (broken line or smooth curve), left-clicking or right-clicking to 
determine the start point and the end point does not make any difference to a line segment. As to a 

Sk regional boundary, however, it determines the smoothness of this point. 

Insert an Area 

The user can use insert an Area to insert Smooth or unsmooth areas. 

1. Click Insert menu, and then select Area 3. from Shape sub-menu or click insert Area 6 in the toolbar. 

2. The cursor becomes a pencil with a plus. Move the cursor to the desired position, and then left-click or 
right-click to determine the starting point of the inserting area. Again move the cursor to proper position and 
then right-click or left-click to determine the broken points or consecutive points of this area ... click repeatedly 
until you press Enter key to stop the operation. 

3. Before finishing inserting an area, you need not to link the starting point and the ending point manually. 
Once you press the Enter key, AutoStitch will judge if they are broken points or consecutive points 
automatically and link the starting point and the ending point together to form a complete closed area. 

Tips: 

"topic-136 
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1. Once select insert an area, the insert operation will be started and will last until you press Enter 
key. However, you can cancel the operation at any time by pressing the ESC key. 

2. if the inserted area is unsatisfactory, left-click to select it and press the Del key to delete it. Also, 
you can right-click to select it and modify it in many ways. 

3. Every newly-inserted object is an independent group. 

Note. 

1. While inserting an area, if the middle points are all determined by right-clicking, these points are 
broken points. If they are all determined by left-clicking, they are consecutive points. Of Course, you 
can determine these middle points by partially left-clicking and partially right-clicking, thus they will 
form an area which is partially smooth and partially unsmooth. 

2. This operation is different from Insert a regional boundary of an area by using the insert a line 
function. 

Warning. 

While using this function, the user is not allowed to press the Enter key to conclude the operation if 
the user has determined only two points i.e. a starting point and ending point. If you did So, the 
inserted area will not appear. After all, at least three points are needed to define an area. 

The difference between using inserting an area and inserting a regional 
boundary of an area by using insert a line 
1. To form a closed curve, the starting point and the ending point of the former will become linked 
automatically by using insert an area, but those of the latter must be linked manually. 

2. Before generating, they looks almost the same. But after generating, you will find that the former forms an 
area which is full of stitches and the latter is only a hollow area and there are stitches only on the boundary in 
it. 

3. While selecting, you can select the former by clicking any point inside the area, but you can only Select the 
atter by clicking its boundary. 

Troubleshoot printing 

What do you need incip with? 

When I try to print a Design nothing happens 
o Desion runs off the edde of the pace 
o The Print Sample Command on the File menu is dimmed 

When I try to print a Design nothing happens. 

o First, make sure whether a problem exists with your printer setup in Windows or in AutoStitch by using the 
Windows Print Troubleshooter. On the Windows Startmenu, click Help, Click the Index tab, and then 
enter "print troubleshooting". Click Display, and then follow the instructions in the Windows Print 
Troubleshooter. 

"topic-14 1-1 
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o if your Windows printer setup looks alright, check your AutoStitch printer settings. 
Make sure that the selected printer matches the printer you are using. On the File menu, click Print, and 
then click the name of the printer you want to use in the Name box. 
Make sure that the page range you have selected in the Print dialog box Corresponds to the pages you 

i want to print. 

Design runs off the edge of the page 

o Make sure that you have selected the correct printer. 

k Make sure that you have selected the correct paper size by clicking Print Setup on the File menu. 

Fila HOle 

AutoStitch provides the user with Fila Hole which enables the user to delete the inner Contour of an area. 

1. Right click or drag with the right button to select one area. 

2. Select Fila Hole 3. from the Outline menu or click Fill Hole 8 in the toolbar, and then you will find the 
Cursor becomes a hand. Point the cursor to the selected area. If an area has inner Contour and the inner 
contour is highlighted with red, delete an inner contour is valid in this area. 

3. Left-click this highlighted area, you will find the inner contour which you deleted disappears. 

Tip: 

When using Filt a Hole, it is valid only when the inner contour is highlighted with red. 

Notes. 

1. When using Fill a Hole, only one area can participate in the operation at one time, and you must 
right-click to select it. During the process of deleting, right-clicking will cancel this operation. 

2. Press the Esc key to escape this operation. 

3. When left-clicking to determine the inner contour that you want to delete, the inner Contour must be 
highlighted with red when the cursor points to the inner contour, otherwise the operation is invalid. 

The Print Sample command on the File menu is dimmed 

Your printer may not be selected, or the printer driver may not have been installed properly. On the 
Windows Start menu, click Help. Click the Index tab, and then search for "printer drivers, installing". 

o if your printer is already selected, select a different printer to see whether the command becomes 
available. 

o if the command is still dimmed, re-install your printer driver according to the instructions in Microsoft 
Windows Help. 

"topic-138-140 
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Add To | Subtracting From 

To add an object or an area to an existing selection, press and hold down the Ctrl key while selecting the new 
object or area. 

To remove an object or an area from an exiting selection, press and hold down the Ctrl key while selecting the 
object or area, which has already been selected. 

in AutoStitch, left-click to select an object, and right-click to select an area. 

Undo 

Undo Command reserves the last edit to the active object. It can restore the last steps of previous operations 
Such as inserting, deleting, editing,orientation alteration, color alterations, etc. To use the Undo Command, 
you can: 

o Select undo g from Edit menu, or 

O Click on the Undo button a. in the Toolbar, or 

k Press <Ctrl + KZ). 

Delete Command 

Delete Command removes the currently activated objects or areas from the ObjectView window. The Delete 
Command does not send data to the Windows Clipboard. To use the command, you can: 

1. Select an object in the window by clicking on the object or right click on area, or click on the area item in 
Film. 

2. 
o You can select Delete from Edit menu, or simply 

o Press <DelC. 

Note. 

#Sk The <Delt key is a shortcut to this function. 

Cutting, Copying, and Pasting 

AutoStitch offers three basic commands: cut, copy, and paste. 

o Cut Command 
Copy Command 

. Paste Command 
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Cut Command 

Cut command is available only when the activated object contains a selection. The Cut Command removes 
selected objects from the ObjectView window and sends the current object or selection to the Window 
Clipboard for use in another window. To use Cut command, you can: 

1. Click on the object in the ObjectView window you wish to remove. 

2. 

• Select Cut from the Edit menu 

o Click Cut in the toolbar, or 

o Press <Ctri> + <X>. 

i. The object is removed from the window and placed in the Clipboard. 

Copy Command 

Copy command sends the currently activated object or selection to the Windows Clipboard without affecting 
the original object in the Object View window. The Clipboard contents can then be used elsewhere by using 
the Paste function. To use Copy command, you can: 

1. Click on the object in the ObjectView window you wish to remove. 

2. 
o Select Copy g from the Edit menu 

o Click Copy Effin the toolbar, or 

a Press <Ctri> + <C>. 

The object is copied onto the Clipboard. 

s The original object remains in the window. 

Paste Command 

Retrieves Clipboard Contents that have been cut or copied. Places the contents into the current window. To 
use Paste command, you can: 

1. m 

o Select Paste s from the Edit menu 

a Click Paste s in the toolbar, or 

o Press <Ctrl-Z + <W>. 

"topic-146-147 
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2. The contents of the Clipboard are placed into the ObjectView window, with the center point as the object 
Origin. The contents of the clipboard become an object in the window. 

3. Select the object with your mouse and move it into your desired position. 

Tip. 

Having finished Paste command, the new object will appear in the ObjectView window. 

1. Left-click it. 

#Sk 2. Drag it to any position within the window by holding down the left button. 

Auto-Arrange Entry Position 

Auto-Arrange Entry Position will provide the user with the optimum sequence of the in/Outpoint. "Optimum 
Sequence" refers to rearrange in and Out points of two adjacent areas automatically so that the distance 
between the ln and Out points becomes the shortest one, but it does not change the stitch sequence. 

1. Generate the object in the ObjectView window. 

2. Select Auto-Arrange Entry Position 3. from the Accessories menu. 

Tips: 

1. You can right-click to select one area of the object to see its infout points. If the distance between 
the two adjacent areas is not optimum, once you use this function, you will see their positions 
rearranged. 

2. if the alternation of the In/Outpoints that you made manually is not satisfactory, you can use this 
function to optimize them. 

Note: 

The changes will take effect only after generating, and it will affect all the objects in the Object View 
Window. 

iSk 

Undo Command 

The Undo command allows the user to easily recover from mistakes during editing. The Undo feature allows 
the user to undo most operations that modify an image. 

• If you find your operation wrong, select Undo (from the Edit menu or you can also click the Undo button 

• You can undo several previous operations by repeatedly clicking this button. 

Tips: 

1. In this version you can undo several actions at one time: 

topic-150 
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Click the arrow next to a to view a list of the most recent actions you can undo. Select the action 
you want to undo. If you do not see the action, scroll through the list. Drag the mouse to include all 
the actions you want to undo or click the last action of the series actions you want to undo. When you 
undo the last action, you also undo all actions above it in the list. 

2. If you later decide you didn't want to undo an action click the redo button S. 

Note. 

isk The Undo menu items become dimmed when they are unable to be run. 

Move object(s) a short distance within a window 

1. Select the object(s) you want to move. 

2. To move the selection, drag the selection where you want to paste or be located. 

Note: 

Sk if you drag the selection beyond the visible window, your design will scroll in the same direction. 

Move or Copy object(s) long distances or to other Designs 

1. Select the object(s) you want to move or copy. 

2. To move the Selection, Select Cut from Edit menu. 

To copy the selection, Select Paste from Edit menu. 

3. If you want to move or copy object(s) to another design, close the current design, and then load the design 
in which you want to paste. 

4. Click where you want your object(s) to appear. 

5. Select Paste from Edit menu. 

Use the mouse to scroll through a Design 

After scrolling, click the location where you want to start working. 

To Do this 

Scroll up one screen Click above 2 

Scroll down one line clicky 
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Scroll up one line Click 

Scroll down one screen Click below -l 

Scro left Click 

Scroll right Click 
Sk 
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While embroidering, if the small area is embroidered directly on the cloth, the small area is called un-floated 
area. If the small area is embroidered upon the embroidered substratum area, the small area is called floated 
area. 

Different users may have different needs, so AutoStitch provides you with Float Area(s) and Un-Float Area(s). 

1. Switch to Outline VieW, 

2. Right-click one area which has been floated. 

3. Select Un-Float Area(s) from the Outline menu. 

4. Right-click the area which encloses these small areas, and then click Generate. 

5. Select Auto-Arrange Embroidery Order from the Accessories menu. 

6. You can click Quick View to view the effect you have created. 

Tip. 

if you want to view whether the small area is floated or not, right-click the larger areas which enclose 
the Small areas. If the border of the Small area is flashed with blue and White dotted lines, it ShoWS 
that the small area is not floated, and the large area(s) will make room for the small area(s). If the 
border of the small area is not flashed with blue and white dotted lines, it shows the Small area is 
floated and the larger area will not make room for the small area. 

Notes. 

: After this operation: 

1. You must regenerate the larger areas which enclose the small areas so as to create stitches 
according to the new blocks. 

2. You must select Auto-Arrange Embroidery Order, otherwise the should-be un-floated area(s) may 
be covered by the substratum area(s). 

i 3. You can only un-float one area at a time, you must un-float them one by one if you want to un-float 
Several areas. 

#Sk 

Protect a Design 

o Assign a protective password, which prevents unauthorized users from opening the design or Stitch file. 

Caution. 

if you assign password protection to the design and then forget the password, you cannot open the 
design, remove protection from it, or recover data from it, it is a good idea to keep a list of your 

#Sk passwords and their corresponding file names in a safe place. 

Require a paSSWOrd when a Design is Loaded or accessed 
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1. Load the Design. 

2. On the File menu, click Save Design As. 

3. Click the Password Protect checkbox. 

4. In the Password dialog box, type a password in the Enter box. 

5. in the Password dialog box, type the password again in the Confirm box, and then click OK. 

6. Click Save. 

PassWord 

Prevents access to the protected design by unauthorized users. A password can contain any combination of 
letters, numerals, spaces, and symbols, and it can be up to 15 characters long. As you type a password, 
AutoStitch displays an asterisk(*) for each character you type. Passwords are case-sensitive. 

Change or delete a password 

You must know the password to load the design. 

1. Load the design and type its original password. 

2. On the File menu, click Save Design As. 

3. To change the password, check the Password Protect checkbox and type the new password twice, and 
then click OK. 

To delete the password, make sure that the Password Protect checkbox is unchecked. 

4. Click Save. 
Sk 

Troubleshoot protecting a Design 

o The password typed to load a Design does not work 
i 

The password typed to load a Design does not Work 

Passwords are case-sensitive. Check to see whether the CAPSLOCK key is on, or retype the password to 
lake sure you did not mistype it. 

Flip 
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Flip can turn one or several selected objects according to certain requirements. There are two ways to Flip in 
AutoStitch. The Flip command reverses a object or selection's orientation along the vertical and horizontal 
axeS. 

o Vertical Command 
o Horizontal Command 

Note. 

i This operation functions only on the selected object. 

Vertical Command 

Can flip one or several selected objects vertically. 

1. Select one or several objects that you want to flip. 

2. Select the Edit menu then click the Flip Vertically sub-menu from the Flip. You can also click Flip 
Vertically button in the toolbar. Thus the selected objects will flip 180 degree vertically. 

Notes. 

1. The Vertical command reverses the image or selection vertically so that what was on the top 
becomes the bottom, and vice-versa. To use the command, select Flip from Object menu and then 
select Flip Vertically from the Flip sub-menu. 

2. If you selected several objects, every object will flip 180 degree vertically and independently, if you 
select one object, the whole object will flip 180 degree. 

i 3. If you flip an object two times on the same axis, the object will resume its original state. 

Horizontal Command 

Can flip one or several selected objects horizontally. 

1. Select one or several objects that you want to flip. 

2. Select the Edit menu, and then click the Flip Horizontally sub-menu from the Flip. You can also click 
Flip Horizontally a button in the toolbar. Thus, the selected objects will flip 180 degree horizontally. 

Notes. 

1. The Horizontal command reverses the image or selection horizontally so that what was on the left 
side becomes the right side, and vice-versa. To use this command, select Flip from Object menu and 
then select Flip Horizontally from the Flip sub-menu. 

2. If you selected several objects, every object will flip 180 degree horizontally and independently; if 
you select one object, the whole object will flip 180 degree. 

iSk 3. If you flip an object two times on the same axis, the object will resume its original state. 
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Rotating an Object 

The Rotate command allows you to rotate an object by a specified number of degrees. 

1. Left-click to select an object. 

2. Select Rotate from the menu and then click the proper sub-menu or click the proper button in the toolbar. 

There are several ways to Rotate an image in AutoStitch. 

O Left 90 Degrees 
o Right 90 Degrees 
o Manually 

Left 90 Degrees A is a counter-clockwise 90 degree revolution accomplished by clicking the Left 90 Degree 
button. 

Right 90 Degrees R is a clockwise 90 degree revolution accomplished by clicking the Right 90 Degree 
button. 

Manually sh sub-menu (Specified Rotation) 

input your desired number of degrees in the pop-up Free Rotate dialog box, and then click OK. The object 
which you selected will rotate the specified number of degrees. The default number of degrees is 0. 

Tips: 
1. If you wish the object to rotate clockwise, the number of degrees should be positive. If you wish 
the object to rotate counter-clockwise, the number of degrees should be negative. 

2. The number of degrees entered may be an integer, decimal, or fraction. 

You can rotate the object by using the mouse to drag and set the degrees of rotation. 

3. AutoStitch also provides the user with a convenient and auto-visual way of rotating. The user does 
not have to select Rotate from the Edit menu, instead one can do it directly in the Object View 
WindoW. 

BSk 

Group/Ungroup Command 

Group/Ungroup Command can group or ungroup the objects/sections you have previously selected. 

1. Left-click one or several objects/sections. You will see them enclosed by eight points. 

2. Select the Group/Ungroup ji from the Edit menu or click the Group/Ungroup button r in the toolbar. 

Tips: 
1. If you want to select several objects/sections consecutively, use the mouse to drag a rectangular 
frame to enclose all the objects/sections. If you want to select several objects/sections 
simultaneously other than Consecutively, click the first object/section and then hold down the Ctrl key 
to click every desired objects/sections. (To hold down the Ctrl key and click means to add new 
objects/sections and to reserve the previously-selected objects/sections.) 

"topic-167 
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2. if you want to cancel all the selected objects/sections, click the blank space outside these objects. 
if you want to select a new object/section, click it. 

3. If you want to select one group, click any elements of the group. it will not work if you click the 
blank space among these elements. If you want to select one ungrouped element, click the element 
itself. Once several elements are selected at the same time, all the operations you do afterward will 
function to them all. 

Notes. 

1. Group/Ungroup command can only function when the selected objects/sections are enclosed by 
eight points, otherwise the Command will be dimmed. 

2. The effect of Group/Ungroup relies on the state of the selected objects/sections. If they are 
already grouped, click the command to eliminate the grouping so that the object explodes into many 
individual objects. If they are ungrouped, clicking the command so that the selected objects are 
grouped together. 

3. The scope of validity of Group/Ungroup depends on the numbers of the selected objects/sections. 
To group or ungroup one object is to group or ungroup every element of this object. To group or 
ungroup several objects is to group them into a bigger one or ungroup them into several smaller 
objects. 

isk 

Align 

Align can arrange several selected objects according to certain requirements. Usually for align a string of 
alphabets. In this case, user should use the group/ungroup operation to treat this string. There are eight 
ways to Align in AutoStitch. 

Align by Top 
Align by Bottom 
Align by Left 
Align by Right 
Align by Baseline 
Align by Horizontally Center 
Align by Vertically Center 
Align by Curve 
Align by Arc 

Tip. 
You can align after selecting several objects. In addition, you can also align after ungrouping an 
object and selecting several elements of it. 

Notes. 

1. When you have not selected any objects/sections or have only selected one, the previous seven 
ways cannot be used. 

2. In the process of Align, the newly-selected objects/sections will be aligned by the first-selected 
One. 
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Align by Top 

Can align selected objects by the top line. 

1. Select several objects. 

2. Select Edit menu and then click the Align By Top sub-menu from the Align. You can also click Align 
Top button in the toolbar. 

Notes. 

1. The selected objects are aligned by the top line in which the upper three points of the eight ones 
around the first-selected object locate, but their x-coordinates remain unchanged. 

2. When several objects are selected simultaneously, this operation will affect all of them. If you want 
to cancel this select, click the black space of the Object View window. 

Align by Bottom 

Can align the selected objects by the bottom line. 

1. Select several objects. 

2. Select Edit menu, then click Align By Bottom sub-menu from the Align. You can also click Align Bottom 
button in the toolbar. 

Notes. 

1. The selected objects are aligned by the bottom line in which the bottom three points of the eight 
ones around the first-selected object locate, but their x-coordinates remain unchanged. 

2. When several objects are selected simultaneously, this operation will affect all of them. If you want 
to cancel this select, click the black space of the ObjectView window. 

Align by Left 

Can align the selected objects by the left line. 

1. Select several objects. 

2. Select Edit menu, and then click Align By Left sub-menu from the Align. You can also click Align left 
button in the toolbar. 

Notes. 

1. The selected objects are aligned by the left line in which the left three points of the eight ones 
around the first-selected object locate, but their y-coordinates remain unchanged. 

2. When several objects are selected simultaneously, this operation will affect all of them. If you want 
to cancel this selection, click the black space of the ObjectView window. 
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Align by Right 

Can align selected objects by the right line. 

1. Select several objects. 

2. Select Edit menu, and then click Align By Right sub-menu from the Align. You can also click Align 
Right button in the toolbar. 

Notes. 

1. The selected objects are aligned by the right line in which the right three points of the eight ones 
around the first-selected object locate, but their y-coordinates remain unchanged. 

2. When several objects are selected simultaneously, this operation will affect all of them. If you want 
to cance this selection, click the black space of the Object View window. 

Align by Baseline 

Can align the selected objects by the baseline. 

1. Select several objects. 

2. Select Edit menu, and then click Align By Baseline Eg sub-menu from the Align. You can also click Align 
Baseline button in the toolbar. 

Notes. 

1. The selected objects are aligned by the baseline of the first-selected object. 

2. When several objects are selected simultaneously, this operation will affect all of them. If you want 
to cancel this selection, click the blank space of the ObjectView window. 

Align by Horizontally Center 

Can align the selected objects by the horizontally center line. 

1. Select several objects. 

2. Select Edit menu, and then click Align By Horizontally Center sub-menu from the Align. You can also 
click Align Horizontally Center button in the toolbar. 

Notes. 

1. The selected objects are aligned by the horizontally center line in which the two horizontal middle 
points of the eight ones around the first-selected object locate. But their x-coordinates remain 
unchanged. 

2. When several objects are selected simultaneously, this operation will affect all of them. If you want 
to cancel this selection, click the black space of the ObjectView window. 
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Align by Vertically Center 

Can align selected objects by the vertically center line. 

1. Select several objects. 

2. Select Edit menu, and then click the Align By Vertically Center sub-menu from the Align. You can also 
click Align Vertically Center button in the toolbar. 

Notes. 

1. The selected objects are aligned by the vertically center line in which the two vertical middle points 
of the eight ones around the first-selected object locate. But their y-coordinates remain unchanged. 

2. When several objects are selected simultaneously, this operation will affect all of them. If you want 
to cancel this selection, click the black space of the Object View window. 

Align by Curve 

Can align selected objects by the given curve. 

1. Select several objects. 

2. Select Edit menu, and then click the Align By Curve sub-menu from the Align. You can also click Align 
Curve buttons in the toolbar. 
3. Now, the original cursor will become the shape of a pen. To draw a curve, left-click any place you want in 
the ObjectView window to define the start point of the curve. Move the cursor with mouse to any place in the 
Object View window and left-click to define the middle point of the curve. Move the cursor and right-click to 
end this curve. At this time, right-click a spot as the end point of the curve. The selected objects will align by 
this curve. 

s: 

Notes. 

." 1. The selected objects are aligned by the self-drawn curve and both their x/y-coordinates will change 
a little bit. Sometimes objects will convert according to certain requirements. 

2. When several objects are selected simultaneously, this operation will affect all of them. If you want 
fiSk to cancel this selection, click the black space of the ObjectView window. 

Zoom 

Zoom enables you to zoom in or out of the image in the Object View window. There are five ways to Zoom in 
AutoStitch. 

Last Zoom 
Zoon in 
Zoom Out 
Natural Size 
Zoom Object 

"topic-168-176 
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e Zoom All 

Tips: 

1. if you want to operate the entire design in the ObjectView window, Last Zoom, Natural Size, and 
Zoom All can be performed by clicking the command. To perform Zoom in and Zoom out, you need 
to click not only the command but also any one position in the ObjectView window. 
if you want to operate part of a design in the ObjectView window, only Zoom in and Zoom Out will 
work. Click the command, and drag a rectangular frame to enclose the operative object, the selected 
object will be zoomed in or zoomed out and placed in the center of the window. 

2. The difference between these two ways: the former can use any one of the five ways and zoom in 
or out proportionally; the later can only use Zoom in or Zoom Out and the object always lies in the 
center of the Object View window, but the change is not proportional. The smaller the rectangular 
frame you drag is, the bigger the multiple of zoom in or out, on the other hand, the larger the 
rectangular frame you draw is, the smaller the multiple of zoom. 

Notes. 

1. You should select the command before selecting the objects which you want to Zoom. 

2. Zoom All, Zoom in and Last Zoom are likely to make the size of the images to go beyond the limit 
# of the ObjectView window. 

Last Zoom 

Can regenerate the last zoom size chosen prior to the current view in the Object View window. 

Select the View menu and then click the Last Zoom sub-menu from the Zoom. You can also click Last 
Zoom button in the toolbar. 

Notes. 

1. The effect is just like Zoom Undo/Zoom Redo, but takes only one step. 

2. it affects all the images in the Object View window. 

3. it can be used together with Zoom in and Zoom Out. 

Zoom in 

Zoom in is used to magnify an object or even a part of an object to ease the editing process and see more 
clearly. 

o Zoom. In by Clickin 
Zoom in by dragging a rectangular frame 

Tip. 

You can right-click any place in the ObjectView window to cancel the working state of Zoom in. 

Notes. 

1. The effect of zoom in will last until you click Zoom in button again or switch to Zoom Out button. 

"topic-177-178 
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2. Zoom in can be used together with Zoom All, Last zoom, and Natural Size at the same time. 

i 3. This effects the window only and does not change the size of the object. 

Zoom in by clicking 

1 Select View menu and then click Zoom in S sub-menu from the Zoom. You can also click Zoom in button 
in the toolbar. The cursor will change to a magnifying glass with a plus sign to identify Zoom in. 

2. Click or repeatedly click the ObjectView window so that all the images are magnified to a suitable 
proportion. 

3. Release the left mouse button and the object or even the part of the object will be magnified to fill the 
Window. 

4. Once you select the Zoom in feature, you may perform the process repeatedly without selecting it again. It 
Will deselect When another function is Selected. 

Notes: 

1. it affects all the images in the ObjectView window. 

2. Each click will enlarge the images by 20% from the previous size, but the maximum enlargement 
Scale is 3200%. If the maximum value is reached, the function will no longer work. 

Zoom in by dragging a rectangular frame 

1. SelectView menu and then click the Zoom in & sub-menu from the Zoom. You can also click Zoom in 
button in the toolbar. The cursor will change to a magnifying glass with a plus sign to identify Zoom in. 

2. Within the ObjectView window, start a selection by left-clicking and dragging the mouse. A rectangle 
should be drawn, showing the area you want to zoom. You can drag the rectangular frame once or several 
times repeatedly so that the image will be magnified proportionally. 

3. Release the left mouse button and the object or part of the object will be magnified to fill the window. 

4. Once you select the Zoom in function, you may perform the process repeatedly without selecting it again. 
it will deselect when another function is selected. 

Notes. 

1. All the images in the ObjectView window will be enlarged, but the selected object(s) will be 
displayed in the center of the ObjectView windows. 

2. Each enlargement has no proportional association, but the smaller the rectangular frame you drag 
is, the bigger the multiple of zoom in is, 

Zoom Out 

Zoom Out is used to reduce an object or even a portion of an object. 

Zoom Out by Clicking 
"topic-179-180 
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Zoom Out by dragging a rectangular frame 

Tip. 

You can right-click any place in the Object View window to cancel the working state of Zoom Out. 

Notes. 

1. The effect of zoom out will last until you click the Zoom Out button again or Switch to the Zoom in 
button. 

2. Zoom Out can be used together with Zoom All, Last zoom, and Natural Size at the same time. 

3. This affects the window only, it does not change the size of the object. 

Zoom Out by clicking 

1. Select the View menu then click the Zoom Out 9 sub-menu from the Zoom. You can also click the Zoom 
Out button S in the toolbar. The cursor will change to a magnifying glass with a minus sign to identify Zoom 
n. 

2. Click or continually click the Object View window so that all the images are lessened to a suitable 
proportion. 

3. Once you select the Zoom Out function, you may perform the process repeatedly without select it again. It 
will deselect when another function is selected. 

Notes. 

1. it functions on all the images in the Object View window. 

2. Each click will reduce the images by 20% from the previous size, but the minimum shrinkage Scale 
i is 10%. If the minimum value is reached, it will stop reducing. 

Zoom Out by dragging a rectangular frame 

1. Select the View menu then click the Zoom Out g sub-menu from the Zoom. You can also click the Zoom 
Out button in the toolbar. The cursor will change to a magnifying glass with a minus sign to identify Zoom 
Out. 

2. Within the Object View window start a selection by pushing the left mouse button down and while holding it 
down drag the mouse. Draw a rectangle showing the size you want the object Scaled to. You can drag the 
rectangular frame once or several times continually so that the image is reduced proportionally. 

3. Release the left mouse button and then the object is redrawn to the size of the rectangle. 

4. Once you select the Zoom Out function, you may perform the process repeatedly without selecting it again. 
it will deselect when another function is selected. 

Notes. 

1. All the images in the ObjectView window will be reduced, but the selected object(s) will be 
displayed always in the center of the Object View windows. 

"topic-182-183 
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2. Each shrinkage has no proportional association, but the smaller the rectangular frame you drag is, 
s the bigger the multiple of zoom out. 

Natural Size 

Natural Size is used to scale the object shown in the ObjectView window to the virtual embroider-out size. 

Select View menu and then click Natural Size sub-menu from the Zoom. You can also click the Natural 
Size button Q in the toolbar. The object is redrawn to the natural size of the object. 

Notes. 

1. it affects all the images in the Object View window. 

2. The effect will not last, and it works only on an object whose current measurements are not the 
same as its natural size. Otherwise, there will be no change in your selected object. 

3. it can be used together with Zoom in and Zoom Out. 

4. Natural Size assumes that the monitor is properly adjusted. 

Zoom All 

Can size all the objects to the Object View window. 

Select View menu and then click Zoom All sub-menu from the Zoom. You can also click Zoom All button 
in the toolbar. The object will be redrawn to fit within the ObjectView window. 

Tip. 

When the cursor points to the frame between the Picture View window and the ObjectView window, 
the cursor turns into (--). By dragging it to the left or right, you can adjust the size of the two 
Windows. 

Notes. 

1. it affects all the objects in the ObjectView window. 

2. When the object is not displayed in the ObjectView window after a series of operations (except cut 
and delete), you can use Zoom All to redisplay the object in the central part of the window. 

3. The effect of zoom all will not last, and it works only when the design is not fully displayed in the 
ObjectView window or not placed in the center of the Object View window. 

4. It can proportionally enlarge or reduce the images with the size of the ObjectView window. 

5. it can be used together with Zoom in and Zoom Out. 

Sk 6. This affects the window only, and does not change the size of the object. 

Pan 

"topic-177-185 
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Pan provides the user with a quick repositioning of the view in the window. The Pan Command permits you to 
view an area of a window centering around a circle with a crosshair in the middle in the window. 

1. Select Pan g from the View menu. You can also click the Pan button g in the toolbar. 

2. The cursor turns into a panning cursor that looks like a circle with a crosshair in the middle -- identifying 
Pan. 

3. Place the cursor in the Object View window where you want to reposition the object, and click one time. 
The object is re-drawn with spot on the object where you clicked the mouse be positioned in the center of 
window. 

Note. 

1. When you drag the object and hold down on the left button, you will find that the whole object or 
part of it will be displayed in the Object View window and can not be moved out of the window no 
matter how you drag the object. (The premise is to drag the object without releasing the left button) 

2. if you insist on moving the object out of the window, you need to drag them individually, and you 
should not hold down the left mouse button at the moment in addition, when you want to select a 
partially-displayed object by dragging a rectangular frame, you will find that the object will move up 
and down or left and right so that you can finally enclose the object. It will be more convenient than 
using Zoom All and then dragging a frame to select the object. 

The above-mentioned conditions are due to the fact that AutoStitch imperceptibly provides the user 
Sk with an Auto-Pan, which can move the screen automatically with object. 

Ruler 

Ruler is used to determine the width and height of your image, You can also determine the length of stitches, 
or the diagonal measurements of your design. 

1. Select Ruler 9 from the View menu. You can also click the Ruler button 9 in the toolbar. 

2. Place the cursor (the cursor changes to a ruler with a plus), at the point you wish to start measuring from. 

3. Click and hold down the left mouse button, and drag the cursor to the point you wish to measure to. The 
status Bar at the bottom of the screen displays the measurements in both the X (horizontal) and Y (vertical) 
directions in the Pos frame of the status bar, and measurements are shown in inches or mm on the left side of 
the status bar. 

Note: 

if the Status bar is disabled, the Ruler is still available but there is no place for measurements to be 
iSk displayed. 

Select 

Selecting an object or even selecting several areas is the first step in a variety of editing tasks. You can 
move, Copy, delete, Flip, Rotate an object, or Rotate several areas which are selected, and more. 
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Add To / Subtracting From 
Selecting an entire object 
Select Al Areas 
Select All Lines 
Select By Color 
Removing a Selection 
Inverting a Selection 

Select an entire object 

To select the entire objects, select the Edit menu, and then click Select All from the Select sub-menu. You will 
find all the objects in the ObjectView window will be selected automatically. 

Removing a selection 

To remove a selection from the activated object(s): 

O Select the Edit menu, and then click Select None from the Select sub-menu. 

You can remove a selection by left-clicking the blank space outside the object in the Object View window. 

Inverting a selection 

To swap a selected area and a non-selected area, select Edit menu, and then click invert Selection from the 
Select Sub-tenu. 
Sk 

Exit 

Selecting this item from the File menu will exit AutoStitch while closing all of its open windows and bring you 
to the Window Program Manager. If you have an object in the ObjectView window, and changes have been 
fade to it, you will be prompted to save the changed object before exiting. 

Outline View 

Outline View is used to enable or disable the outline of the object in the ObjectView window. Select Outline 
viewis from the View menu or click on the Outline View button (s in the toolbar. If it has been selected, the 
object will be displayed in the form of a real outline. 

Notes: 

1. When you first launch AutoStitch, outline view is on by default. 
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2. You can switch among Outline View, Block view, and Stitch view, but only one of the three views 
can be activated at a particular time. 

isk 3. You can switch among the three views before doing any operations. 

Block View 

Block View is used to enable or disable the view of blocks which are inside the generated Column fill area of 
the object in the Object View window, usually for one color geometry entity with large border to area ratio. 
Select Block View from the View menu or click on the Block View button it in the toolbar. If it has been 
Selected, the object will be displayed in the form of a real outline with blocks inside the column area. 

Notes. 

1. When you first launch the AutoStitch, Outline View is the default status. Even if you select Block 
View, the object will continue to show the real outline until you generate and select it again. 

2. Only geometry entity (area) for column stitch generation will show blocks. 

3. You can switch among Outline View, Block view, and Stitch view, but only one of the three views 
can exist at One time. 

4. You can switch among these three views before doing any operations. 

5. Column and complex fill are different stitch types, the block view status will display to you which 
area would be filled by column and which area would be filled by complex fill. If some area of the 
object is cut into several blocks with a red line, it means that this area will be filled by Column and at 
the same time without underlay. Those areas that have not been cut into blocks by red line, will be 
filled by complex. 
To embroider according to the outline, if you use column, the direction of the stitch will Surely change. 
Cutting it into blocks, the stitches with the same direction will be grouped into one block. Therefore, 

Sk the directions of stitches of the adjacent blocks are different. 

Stitches View 

Stitches View is used to enable or disable to view the object's stitches as thin lines in the Object View window. 
Select Stitches View from the View menu or click on the Stitches View button in the toolbar. If it has 
been selected after generating, the object will be displayed in the form of stitches, otherwise the object will be 
displayed in the form of a dotted outline. 

Notes. 

1. When you first launch AutoStitch, Outline View is the default status. If you select Stitches View 
without generating, the program will show you the dotted outline without any stitches inside. But if 
you select generate first, then the Stitches View will be used after generating automatically, and this 
view will last until switched to one of the other two view types. 

2. You can switch among Outline View, Block view, and Stitches view, but only one of the three views 
can exist at One time. 

3. You can Switch among these three views before doing any operations. 
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4. The stitch type filling the object depends on whether the object is cut into blocks or not. (You can 
Select the Block View to view the blocking condition.) This is the best embroidering effect that 
AutoStitch can provide you. Of course, this may not be the final effect, and you can modify it 

iSk according to your requirements to get the desired effect. 

Generate 

Can generate the stitches of newly-inserted objects or update the stitches of those modified objects. (For 
instance, you can enlarge or reduce the object, or alter the outline of the object manually by dragging the 
mouse, and then select Generate to update the stitches.) 

1. Select Generate 3. from the Accessories menu or click on the Generate button 2. in the toolbar. 

2. Now you will see the stitches inside of the object which you have selected and the Stitch View button is 
checked automatically. 

Tip. 
After modifying objects, you should use Generate. For example, if you reduce or enlarge the object 
manually, the stitches will appear to be too dense or too thinly scattered you need to regenerate the 
design. 

Notes: 

1. if some units are selected (only by holding down the Ctrl key and right-clicking or dragging a frame 
without releasing the right button and at this time it is not necessary for you to use Ungroup first) and 
you click Generate, AutoStitch will only generate or update the stitches of those units and leave 
others unchanged. 
if no units are selected (even if you used Ungroup first and then select some units by holding down 
the Ctrl key and left-clicking or dragging a frame without releasing the left button) and you click 
Generate, AutoStitch will generate or update the stitches of all the units which you have not deleted 
before. 

2. If you insert or move or delete individual stitches in the Stitch View window, Generate will again do 
#Sk nothing to these changes. 

Auto-Arrange Embroidery Order 

Will provide the user with the optimum embroidery order. The optimum order is defined as the least number 
of times for Color change trims and finding out the nearest Inf0ut point of two adjacent areas automatically, so 
as to Save time and reduce Costs. 

1. Generate the object in the Object View window. 

2. Select Auto-Arrange Embroidery Order St. from the Accessories menu. 

Notes. 

1. This function works only after using the Generate function. 
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2. Changing color or changing the entity sew sequence or floating an area or merging areas and 
other modifying operations may enhance the trims and the times of changing color and the distance 
between the input and output points. So Auto-Arrange Embroidery Order button will optimize these 
Conditions. 

3. If you do not want the order of the units arranged automatically by AutoStitch, just click on Undo 
iSk button and arrange the units manually. 

Edit Outline 

If you want to edit the outline of the object, you can: 

1. Check the Outline View button, and then select Edit Outline Mode g" from the Outline Menu or click Edit 
Mode" in the toolbar. Now the Outline View and the Edit Mode button are both checked, which means you 
can edit the outline now. 

2. Right-click to activate one or two units (units here means area or line) in the Object View window. Now 
many editing points will appear on the outline of these activated areas/lines, and the user can use these 
points to edit the outline step by step. 

3. Position your cursor in any point of the outline of the selected unit and right-click an editing point of the 
spline, the tangent of this point and the outline which it lies on will appear, and a green arrow implies the 
direction of the tangent. In additional, the other two editing points which lie in the right and left side of the 
Current activated spline will also display the tangents and their direction. 

4. In the pop-up right-clicking shortcut menu, choose Delete Point, and then the editing points of the activated 
spline will be deleted. When there are many editing points in an area and some of them are unnecessary, the 
user can use this way to delete those unnecessary ones. This will not affect the final effect and it helpful for 
the following operations. Nonetheless, an area must have at least three editing points for the spline. 

5. In the pop-up right-clicking shortcut menu, choose Smooth, and then the outline formed by the three 
editing points will become a smooth outline. 

6. After editing, you can click Generate to view the effect you have created. AutoStitch changes to Stitch 
View and sets Edit Mode unchecked automatically. 

Tip: 

When point the cursor to the green arrow which implies the direction of a tangent, an shape-changing 
mark will appear under the lower left corner of the cursor. Now you can move the cursor to change 
the shape of the outlines formed by those editing points of the activated spline. If the outline that you 
are modifying intersected with other outlines, the warning message"Self-cross outline!" will appear on 
the SCreen. 

Notes. 

1. If Edit Mode and Outline View are both checked, left-clicking will no longer work to select an 
object. 

2. While running Edit Mode, you can select two units at most. If two units have been selected, you 
can edit the shared border of them. 

3. If you do not want to select any units, right-click the blank space. If you want to select a new unit, 
right-click it. 
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4. Do not make the curves intersect with the same activated entity, otherwise AutoStitch will give you 
a warning message. 

Five points 
The two red points indicate the part that could be changed on the boundary. 
The middle green point of the three is the move point, and you can drag it to change the shape of the 
boundary. 
The other two green points stand for the directions of the curve in that point. You can drag those points to 
Shange the direction of the Curve. 

Create 

AutoStitch provides the user with many ways to create lines, line-like areas, or an area's border. 

Create Line from Area(s)'s Border(s) 
Create Lines from Area(s) 
Create Line-like Area(s) from Line(s) 
Create Area's Border from Lines 

Note: 

1. If you select an area, the sub-menu: Line from Area(s)'s Border(s) and Lines from Area(s) under 
the Create menu are available to you. If you select a line, the sub-menu: Linelike Area(s) from Line(s) 
and Area's Border from Lines under the Create menu are available to you. 

2. The similarities and differences of Convert and Create function. 

isk 

Create Lines from Area(s) 
Creates one or several center lines according to the state of the selected unit. 

1. Right-click an area or hold down the Ctrl key and right-click the areas. Release the Ctrl key when you 
finish selecting. You will see all the areas that you have selected filled with a gray Color. 

2. Click the Outline menu and then select the Lines from Area(s) sub-menu from the Create menu, you will 
see some center lines (according to the shape of the areas you have selected) inside every selected area. 

Note: 

The program can run one or several areas at the same time. 
isk 

Create Line from Area(s)'s Border(s) 
Can Create the outside border or all borders of the selected area. 
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es by step instructions 
-m-m- 

Step 1: Access the Convert area to outline dialog box al 

1. Right-click an area or hold down the Ctrl key and right click the areas, and release the Ctrl key when you 
finish selecting. 
Select the whole object by right-clicking and dragging the mouse without releasing the right button. If you only 
want to cancel one unit, hold down the Ctrl key and right click it. You will see all the selected units filled with 
a gray color. 

2. Click the Outline menu and then select the Line from Area(s)'s Border(s) sub-menu from the Create menu. 

Step 2: choosing the desired states a 
AutoStitch provides the user with two options. 

8 Outside border 
o All borders 

left-click either of these two options which are under Apply. 

Outside border 

Creates a new closed border according to the original outline of every selected area. 

All borders 

Creates a new outside closed border according to the original outline of every selected area. In addition, if the 
selected area is dug out inside, an inside closed border will be created according to the inside outline. 

Step 3: Setting the value of the Outline Offset (s 

1. input the desired value into the frame. 

2. Click OK. The outside border or all the borders of those selected areas will now be displayed in the Object 
View window. 

Tip: 
Under the default state, the measure is mm and the offset value is 1. Offset refers to the vertical 
distance from every point of the border to the original outline of the selected area. 

Note. 

Under the default state all the inside and outside closed borders are independent and they become 
new units. In other words, border(s) created under the default state and the originally selected units 
or objects are not grouped. This means that you can select unit(s) or border(s) individually, therefore 

#Sk Generate at this time only affects all the borders of the selected units instead of the units themselves. 
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Merge Areas 

Merge Area enables you to merge two adjacent colored entities (areas) into one area and the outline of the 
Overlapped edges will disappear. 

1. Left-click and then hold down the left button to drag an area and make it overlap with another area. 

2. Right-click and then hold down the right button to drag a frame to enclose the two areas. Now you will see 
them overlapped together and the outline of them will be saved and visible, but the outline of the overlapping 
part will disappear. 

3. Click the Outline View and then select the Areas sub-menu from Merge or click Merge Areas g in the 
toolbar. Then you will see these two areas merged together and the outline in which the two areas overlap 
each other will disappear. Thus, the original two areas will merge into one area. 

Notes. 

1. When you have not select any areas or the number of the selected areas are not two, the Areas 
sub-menu under Merge will become dimmed and can not be used. In addition, you can only use the 
right button to select area(s). (If you use the left button to do it, the sub-menu will also become 
dimmed.) 

2. The areas which participate in merging must be two. Merge will not work if the areas are more 
than or less than two. To merge several areas, you must merge them by two step by step. For 
instance, select area 1 and area 2, and then merge them into a new area. After that, select area 3 
and the one you have just created by merging and then merge them into another one. In this way, all 

Sk the areas can be merged together. 

Edit Block 

if you want to edit the blocks of an area, you can: 

1. Generate those units which you want to edit blocks if they are not generated. 

2. Click on the Block View button and then click the Edit Mode button" (or select the Edit Block Mode g" 
from the Block menu), and now both buttons are checked. 

3. Right-click to select one or several generated area(s). You will see them filled with gray color and red 
lines. These red lines are called dividing lines. 

4. Left-click on one of the dividing lines of the area you want to edit. You will see two green edge points of 
that dividing line highlighted. You can drag either one green point to move the position of this dividing line or 
use the Del key to delete this dividing line. In addition, you can also add dividing lines manually. All these 
operations aim to change the original shape of the blocks. 

5. After editing, you can click Generate to view the effect of your operations and then you will find AutoStitch 
changed to Stitch View and set Edit Mode unchecked automatically. 

Warning. 
AutoStitch Provides the user with many ways to edit blocks, but the following operations are invalid 
and not allowed. 

O Move Dividing Line Warning 

* Merge Areas 
"topic-210 
edit block 

* Edit Block 
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• Delete Dividing Line warning 
Add Dividing Line Warning 

Notes. 

1. You can edit only one dividing line in one area. 

2. if Edit Mode and Block View are both checked, left click will no longer used to select object(s) until 
you cancel Edit mode. 

3. It will be fulfilled only after generating. 

Drag 
If you want to select an object by dragging a rectangular frame, you must enclose the object with this frame, 
therwise the object will not be selected. 

Add a Dividing Line 

After generating objects, the user will see the blocks which AutoStitch provides in the Block View. Generally 
speaking, it is only a recommendation. Of course, you can use Edit Block to move, add or delete the dividing 
lines of the object manually. The function of Add a Dividing Line is to allow users to draw a new dividing line 
in a block so as to change the shape of the original block as well as the direction of the local stitches. 

1. Under Edit Block state, right-click one generated unit. 

2. Select Adda Dividing Line s: from the Block menu or click Add Dividing Line se in the toolbar. 

3. Left-click to define the starting point of the line which you are drawing, drag the mouse until the line 
intersects with two borders of a block and then left-click to define the ending point. At this moment you will 
find two green points appeared in the points of intersection, and the regional line will be reduced into a line 
segment between the two points. The line segment is the new dividing line that you drew, and it will cut the 
original block into two new blocks. 

Tip. 

You can delete the newly-created dividing line so as to recover the original state, or move the newly 
Created dividing line so as to change the shape of the two new blocks. 

Note: 

You can only right-click to select one unit at a time and do the operation of adding a dividing line, 
otherwise the Add a Dividing Line menu will become dimmed. 

Warning: 

In the following cases, you cannot add a dividing line: 

if the dividing line you are adding intersects with another existing dividing line, the warning message 
"Failed to add dividing line" will appear on the screen, which means the operation is invalid. In other 
words, while adding a dividing line, the two edge points of the adding dividing line must lie within the 
same block. Usually the line you draw often creates one dividing line but sometimes it is possible that 
two or more dividing lines are created while drawing a line. Remember every pair of edge points must 
stay in the same block at the same time. 

"topic-211 
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(1) Dividing line 1, which lies in the boundary of an area, can not be deleted 

(2) Dividing line 2, which lies in the common boundary of areas, can not be deleted 

(3) Dividing line 3, shared by three blocks (i.e. three dividing lines look like one dividing line in 
special cases), can not be deleted (dividing line 3 is shared from the three red broken lines) 

Dividing line 3 
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AutoStitch provides the user with many options of the range, type, and some settings of the global underlay. 
This underlay is applied once to the whole embroidery area. 

g Step by step Instructions 

Notes. 

1. it creates a new border of underlay in the selected areas, and neglects the underlay of Some Small 
areas, for example, long and narrow areas. 

2. If you underlay one or several units or even the whole unit, the color of the underlay is determined 
by the first color in the color order list that shows in the status bar and has nothing to do with the order 
of generating. 

3. Underlay can be Created only when you select stitch area. 

4. You should select Generate after Creating a global underlay area to generate global underlay 
Stitches. 

Step 1: Access Global Underlay dialog box st 

1. Select the whole object or entities of the object that you want to modify its underlay. 

2. Select Create Global Underday Area from the Accessories menu. 

Notes. 
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Step 2: Choosing the range (s s 

AutoStitch provides the user with two options of the applied range, and enables you to choose the desired 
underlay area. 
Click to select or deselect "All Area" or "Selected Area". Only one of the two options is highlighted at a time. 

Notes. 

1. When right-click to select several units or the whole object, "Selected Area" is the default. And 
when left-click to select the whole object or nothing, "All Area" is the default. 

2. As long as you have selected All Area, it will automatically shift to underlay the largest area among 
all the generated areas and cancel your previously selected units no matter how many units you have 

i Selected at the beginning. 

Step 3: Choosing types -q s 

AutoStitch provides the user with many types to edit the underlay. 

Left-click to select or deselect Tatami Underlay or Grid Underlay, and only one option of the two is highlighted 
at One time. 
i 

Step 4: Underlay setting (N. p. 

AutoStitch provides the user with two underlay settings. 

Double-click to select Margin or Spacing in the box and input the desired value. You can change the value of 
Margin and Spacing individually. 
Margin offers the distance from the underlay to the border of the underlay. The bigger the value is, the wider 
the distance. ( it is the same in Tatami and Grid.) And Spacing offers the distance from the first run to the 
next one. Similarly, the bigger the value is, the wider the distance. As for Tatami, the distance is that of two 
runs; as for Grid, the distance includes not only the horizontal but also the vertical one. 

Step 5: Check/Uncheck Disable underlay of all areas its a 

if this option is checked, the global underlay area will be created and the original underlay of the units will be 
disappeared after generating all the stitches. If this option is unchecked, the global underlay area will be 
Created and the original underlay of the units will not be disappeared. 

Note: 

if this option is checked and you want the original underlay disappear, you must select all the units to 
i generate. 

Step 6: Creating relevant underlay rq 
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if you want to edit stitches, you can: 

1. Generate the object if you have not. 

2. Select Display Stitch Position % from the View menu or click Display Stitch Position 2 in the toolbar to 
view each needle point for the sake of convenience. 

3. Select Edit Stitches Mode" from the Stitch menu or click Edit Mode "in the toolbar. Then you can use 
Zoom in or Pan to view the region of the stitches which you want to edit more clearly. Now the Stitch View 
and Edit Mode buttons are both checked, which means that you can edit stitches now. 

4. Point the cursor to the needle point where you want to move or add/delete stitches close to it. Click it, and 
a red Cross sign appears. The core of it is the point of stitches that you just click. 

o Move Stitches 
e Delete Stitches 
o Insert Stitches 

Note: 

"topic-224 
edit stitches 

* Edit Stitches 
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ASk Once using Edit Mode, the picture in the Picture View window will disappear. 

Move Stitches 

Left-click the red cross sign (the cursor becomes a cursor with a move sign) and move the cursor to every 
place you want without releasing the left button to reposition the point or to shorten/lengthen the two stitches 
which include this needle point. Release the left button after reposition. 

Tips: 
1. You can use the Up/Down key to move the red cross sign so as to know the direction of the 
running stitches in a certain region. 

2. You can use the Ctrl+ Home/End key to move the red cross sign to the head or tail of stitches of 
the whole design, use the Home/End key to move the red cross sign to the head or tail of the stitches 
of the current unit, and use the Page Up/Page Down key to move the red cross sign 100 stitches up 
or down. 

#Sk 3. Use Pan or Zoom to help you position the point and view the stitches more clearly. 

Delete Stitches 

To delete stitches, it often starts from the needle point which the red cross sign located and deletes the 
stitches following this needle point. So before deleting, you should click the needle point of the stitches (it 
should be the relevant starting needle point of the next following needle points) which you want to delete one 
or several stitches following it. Press Del key. Beware, press Del key one time only delete two stitches in 
which the point is located, and the two needle points which are before and after this point will be connected 
automatically so that all the stitches remain continuous. Click the blank space or stitches without needle point 
on it to cancel the red cross sign. Click another needle point to reselect the edit point. 

Tips: 
1. You can use the Up/Down key to move the red cross sign, so that to know the direction of the 
running stitches in a certain region. 

2. You can use the Ctrl + Home/End key to move the red cross sign to the head or tail of stitches of 
the whole design, use the Home/End key to move the red cross sign to the head or tail of the stitches 
of the current unit, and use the Page Up/Page Down key to move the red cross sign 100 stitches up 
Or down. 

3. Use Pan or Zoom to help you position the point and view the stitches more clearly. 

Note. 

if you click a needle point, what is deleted is the stitches after this needle point according to the Stitch 
Sequence. 

#Sk 

Insert Stitches 

topic-224-225 
move stitches 
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You can select the Insert Stitches from the Stitcl menu to add one or several Stitches. 

Insert some irregular stitches 

1. Click the needle point which you want to insert one or several stitches around it. 

2. Select insert Stitches from the Stitch menu. Once you move the cursor it becomes a cursor with a 
black stitch which comes from the two points (the point you clicked and the previous one). You can move the 
cursor along this stitch to alter the length, direction or width of the newly created stitches. Without any clicking 
at this time, you will find the screen moved with the movement of the cursor. If you do not want to finish 
inserting, left-click and then move the cursor again and again to create the needle points which are between 
these two points we justmentioned. You will find the inserting stitch before left-clicking is black and the 
inserting stitch will become the same color with the area in which you are inserting. 

3. Right click to finish inserting, the point which you have right-clicked will be connected with the next point, 
so the region will be filled with consecutive stitches. 

4. After inserting, you can use Generate and Play Stitches to view the effect of your operation. 

Tips: 

1. You can use the Up/Down key to move the red cross sign so as to know the direction of the 
running stitches in a certain region. : 2. You can use the Ctrl + Home/End key to move the red cross sign to the head or tail of stitches of 
the whole design, use the Home/End key to move the red cross sign to the head or tail of the stitches 
of the current unit, and use the Page Up/Page Down key to move the red cross sign 100 stitches up 
or down. 

3. Use Pan and Zoom to help you position the point and view the stitches more clearly. 

Notes. 

1. To insert some regular stitches, you should click the point which will be the next point after 
inserting. (That is to say the stitches you insert are before the current red cross sign) 

iSk 2. During inserting, to press Esc key can cancel this process and recover to the normal state. 

Film 

in AutoStitch, we provide the user with Film e. which is very convenient for the user to change the sequence 
or color, etc. of embroidery. You can edit each area of the present design in the Film window, the way of 
operation and the final effectare the same with that of the ObjectView window. 

The Film window offers you a series of buttons. On the left side of every "film" there are Visible 9/Invisible 
and Lock f/Unlock two kinds of button. The default state is and 5. You can get the contrary state of 
the two buttons by left-clicking. Except the first "film" every "film" has four buttons: Needle up tie, Change 
Color it/E, Trim 35/36 and Stop Machine 3/8. 
When we feel that it is necessary to use Needle up, Trim, Stop Machine and find that an area and the 
following area have different color, the default states, also called suggestive state, will appear. In other words, 
if the operation is necessary the relevant button becomes highlighted, otherwise these buttons are dimmed. 
Of course, you can alter the default state by left-clicking each button. 

Select the Film from the View menu. 
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Visible O/Invisible gy 
Lock 6/Unlock i? 
Needle up f/6. 
Change Color E/8 
Trinn &/6 
Stop Machine (3/8 

1. You can also change the stitch sequence of units. 
First, left-click to select an unit, suppose it is No.15, which you want to change sequence, and then 
left-click to select your desired position and drag No. 15 there without releasing the left button, 
suppose it is No.5. At this moment, you will find the "films" in the Film window will move upward and 
downward correspondingly. Then you will find the serial number on the left corner of this unit's "film" 
has been changed from the original No.15 to the current No.5 and the original No.5 becomes No.6. 
The rest will rearranged accordingly and automatically. (The serial number indicates the stitch 
sequence while embroidering.) And the embroidery machine will generate stitches according to the 
new sequence. 
in this way, you can change stitch sequence, reduce the times of trimming lines and changing Color. 

2. You can hold down the Ctrl key and left-click several inconsecutive units to change the sequence 
constantly, and finally make these units become a batch of consecutive units in their new positions. 

3. You can hold down the Shift key and left-click several consecutive units to change the sequence. 

4. Left-click any unit in Film window, and a menu will appear on the screen. To click Move to Top 
can move an appointed unit from its present position to that of the first area in the whole Film window. 
To click Move to Bottom can move an appointed unit from its present position to that of the last area 
in the whole Film window. Click properties and to check visible/lock and commands in the pop-up 
properties dialog box is equal to check the relevant buttons of the present unit. 

Notes: 

t 

1. Only after generating can units be displayed in the Film window. 

2. to left-click a unit's "film" is equal to right-click the unit in the ObjectView window. Whichever way 
you choose, the unit will be displayed prominently and In & Out points will be marked. 
Want to reselect a new unit in Film, left-click that unit. Want to deselect all the units in Film, right-click 
the blank space in the ObjectView window. 

3. The series of changes in the Film window except Stop machine will affect the display in the Object 
View window. 

4. The linking line will be displayed with dotted line if there is no trim but needle up between two 
adjacent units. 
The linking line will be displayed with real line if there is no trim and needle up at the same time. 
However, the linking line will be displayed as long as there is no trim. 

Visible of Invisible is 

When the stitches that you want to modify are in the overlapping area and perhaps every area has different 
Colors, you can make the irrelevant areas invisible. In Film window, left-clicking O buttons of some unit's 
"film", and it will becomes. Thus, the relevant unit will become invisible in the ObjectView window. (but it will 
still be reserved in the relevant film) in this way, you can clearly view the area, which you want to modify 
stitches. After finishing modifying stitches, left-clicks of those invisible units to make it become O. Thus, 
those units will again appear in the Object View window. 

"topic-228-229 
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Needle up / 83 

Left-click a Needle up button of an unit in Film in which you feel necessary to use needle up. When it 
becomes highlighted G, it shows that another needle up command is added before embroidering an area. In 
the process of embroidery, the thread between this area and previous one is lifted up. Although it is not 
trimmed, you can trim it manually. When this button becomes dimmed, it shows that the command is 
canceled. Thus the thread between the two adjacent units is embroidered stitch by stitch instead of being 
lifted up (Jump Stitch), and you can not trim it manually. (The thread between the two adjacent units refers to 
the thread from the out point of the previous unit and the in point of the next one.) 

Change Color Be?s 

The default state of Change Color in the Film: if the color of an unit is different from that of the previous one, 
the Change Color button of it will become highlighted automatically. If the color of an unit is different from 
that of the following batch of units (these units are all consecutive) the Change Color button of the first unit 
among them will become highlighted automatically. It shows that one Change color command is here. 
Now if you left-click Change Color button, it will becomes dimmed s. This shows that the change color 
command is canceled, and meanwhile the color of the following one or a batch of units will be the same. 
Now if you left-click Change Color button of some unit, you can modify its color in the pop-up Color window. 
Left-click "Cancel" to exit this window and cancel the operation as well. Left-click "OK" to exit the window. 

Note: 

To add or delete the number of colors in Film will directly affect the color list in the status bar. And the 
i color changing in Film will also directly affect the ObjectView window. 

A batch of units 

Here the so-called a batch of units refer to several consecutive ones under some unit. If they have the same 
color, they will become a batch of units and the Change Color button on their own "film" will be dimmed expect 
the first "film". This shows there is no change color command and they have the same color with the one 
ahead of it. 

Trim/s. 

Left-click a Trim button of an unit in Film in which you feel necessary to use trim. Becoming highlighted 26 
shows that the thread will be trimmed automatically and disappear. Becoming dimmed as shows the trim 
command is canceled and the thread between two consecutive Film windows will not be trimmed, " 
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Stop Machine &/a 
Left-click Stop Machine button in the "film" of the unit that you want to stop the embroidery. Becoming 
highlighted shows that a Stop machine command is added and you can do some operations on the 
embroidering machine after embroidering this unit and before embroidering the next one. 
f want to cancel this command, you only need to left-click this button to make it dimmed. 

Marking "In" & "Out" 
The "in" & "OUT" points will be marked automatically if you right-click a unit or left-click a unit's "film" in the 
Film window. In a unit, "A" indicate the in point, and "(OUT" indicate the Outpoint. As for two adjacent units in 
Film the distance between the Out point of a unit and the in point of the following one is the shortest stitching 
distance. Of course, you can also change the "A" and "OUT" points manually. 
Point the cursor to the "A" or the "OUT"point, and then the original single-head arrow cursor will become 
four-heads arrow "move" mark. Left-click and hold down the left button, you will find the cursor becomes the 
original single-head arrow with "move" mark. Use the mouse to drag "i?" or "tout" or both of them to your 
desired position, and then release the left button. But your operation will be valid only after you generate it 
otherwise the "A" & "OUT" points are changed seemingly and they remain in it's original position virtually." 
Display Stitch Position 
Display Stitch will display all the stitches of the generated areas. This operation enables you to position the 

i cursor accurately in the desired point on the basis that all the stitches are displayed. This is not only auto 
i Visual but also convenient, 

1. Click Stitch View in the toolbar. 

f Select Display Stitch Position 2 from the View menu or click the Display Stitch Position % in the toolbar. 

Play Stitches 
Offers a simulated display of all the generated objects' stitches step by step and from the beginning to the end 
in the order sequence show in film during mock-up embroidery. 

1. Generate the object if you have not already done so. 

2. Select Play Stitches g from the View menu or click Play Stitches g in the toolbar, you will find play 
Stitches window appears with Some familiar and new buttons compared to the previous window. 

Notes. 

1. Zoom, Pan, Ruler, and Draw Stitches, buttons in the new window will affect not only the display of 
the object(s) in this window, but also affect the display of the object in the original window, and vice 
Versa. 

2. Generally, Play Stitches displays the object(s) from the starting stitch. But if you are in Stitch Edit, 
and position the red cross cursor at some needle point, the stitches before the red cross cursor will 
appear automatically and initially in the Play Stitches window. If you click Y. now, the stitches behind 

"topic-228-235 
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New buttons in Play Stitches window 
Clicking this button causes the needle point to travel one stitch towards the ending point. 

: Clicking this button causes the needle point to travel one stitch towards the starting point. 

Besides the above-mentioned two functions, it also combines the function of pause. If you hold down one of 
them, continuous display stitches going forward or going backward will be available to you until you release 
the button. When you hold down the button again, it will resume the state in which you stopped the last time. 

To exit the Play Stitches window and to go back to the original one. Equivalent to clicking * on the 
upper right corner of this window. 

-- To skip the whole process of display and to directly finish displaying all the stitches of the object(s) 
from the starting stitch to the ending stitch. At this moment, it is invalid. 

t To skip the whole process of display and to directly finish displaying all the stitches of the object(s) 
from the ending stitch to the starting stitch, i.e. to return to the starting state. At this moment, is invalid. 

Quick forward and Quick backward are two special buttons and must be used with at least one of the 
i E. : is following five buttons: 10 stitches, 100 stitches 1, 1000 stitches, next color and next units. 

Click the 10 stitches button and then click the Quick forward button individually and you'll find the stitches 
displayed forward by 10 stitches at a time. 
Click the 10 stitches button and then click the Quick backward button individually and you'll find the stitches 
displayed backward by 10 stitches at a time. 

Click the Next color button and then click the Quick forward button individually and you'll find the whole design 
displayed forward according to color list. (If the adjacent two areas are the same in color, they'll be displayed 
at the same time, if not they'll be displayed one after another according to color list.) 

Click the Next unit button and then click the Quick forward button individually and you'll find the whole design 
displayed forward by units. 

Eyou hold down or it will not work, click it singly. 

Cut 1 Split Area(s) 
AutoStitch provides the user with many ways to cut/Split the existing area(s). The user can cut the selected 
area(s) into two or more areas or alter the shape of the selected areas according to requirements. 

a Cut an Area's Border 
Split Area(s) by a Line 

o Cut Area(s) by an Area 

Note. 

"topic-238-239 
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You must right-click to select the area, but left-click to carry out the operation. 
# 

Cut an Area's Border 

The user can use this function and the self-defined line to cut an area's border, and part of the line will 
become a part of the new border of the area. 

1. Right-click or drag the right button to select one area. 

2. Click the Outline menu, and then select Cut an Area's Border from the Cut/Split Area(s) sub-menu. Now 
you will find the cursor becomes a needle with scissors. 

3. Left-click to define the starting point of this line, and then drag the mouse to position, lengthen, or shorten 
the line. Again, left-click so as to make this line cut the area into two or more areas. Now you will find Some 
blank space which does not belong to this area originally patched to the area, and part of the border which 
previously belonged to this area disappears and part of the line you drew becomes the new border of the 
area. 

Notes. 

1. If you want to cut an area's border, only one area can participate in the operation at one time. 
While cutting, you must right-click to select it and left-click to define it. In the process of this 
operation, right-clicking will cancel the operation. 

2. At least two points in the split line must intersect with the outside border of the selected area. In 
other words, the patched blank area is one outside the selected area. 

3. Press the Esc key to cancel this operation. 

4. A split line usually can cut the border into consecutive parts of the outside border, but it also can 
cut the border into several non-consecutive parts of the outside border at the same time. 

Split Area(s) by a Line 

Split Area(s) by a Line enables the user to use the self-defined split line to split one or several areas into two 
Of Ofe areaS. 

1. Right-click or drag the right button to select one or several areas. 

2. Click the Outline menu, and then select Split Area(s) by a Line from the Cut/Split Area(s) sub-menu. 
Now you will find the cursor becomes a needle with scissors. 

3. Left-click to define the starting point of the split line, and then drag the mouse to position, lengthen, or 
shorten, the split line, and left-click again to define its ending point. This line will split the area(s) into several 
parts. 

4. Click one part of them, you will find the area split into two or more parts according to the split line, and 
these parts are independent. 

Tips: 
1. You can perform this operation on several areas of an object at the same time, and you can also 
do it on additional areas from different objects. 

"topic-242-243 
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2. Left-click to select an object, you can use this function to split the whole object into two. However, 
the split line must run across the whole object. 
Right-click to select an area, you can use this function to split the area into two. However, the split 
line must run across the this area. 

3. You can left 1 right-click to select every part of the split area. 

Notes. 

1. When using this function, you must right-click to select one or more areas, and left-click to define 
the split line. 

2. Press the Esc key to cancel this operation. 

3. At least two points in the split line must intersect with the selected area. 

4. A split line can be used to split several selected areas at the same time. 

Cut Area(s) by an Area 

Cut Area(s) by an area enables the user to use an area to split one or more areas into two or more areas. 

1. Right-click or drag the right button to select one or several areas. 

2. Click the Outline menu, and then select Cut Area(s) by an Area from the Cut/Split Area(s) sub-menu. Now 
you will find the cursor becomes a hand. Only when it points to those unselected areas, the outline of those 
areas will be highlighted in red. This indicates that only these areas can be used to cut the selected areas. 

3. Left-click an area whose outline is highlighted in red, the cursor will become an arrow with a moving sign, 
and the area that you have just selected will move with it. 

4. Move this area to the originally-selected area(s) and make them overlap each another. Left-click to define 
the position. Now you will find the selected area(s) is split by the moved area. 

5. Click one of the areas, you will find the selected area(s) split into two or more parts according to the shape 
of itself and the moved area. These parts are independent. 

Tips: 
1. You can perform this operation on several areas of an object at the same time. You can also do it 
to areas from different objects. 

2. You can left/right-click to select every part of the split area. 

Notes: 

1. When using this function, you must right-click to select one or more areas, and left-click to define 
the area that you are going to use to split these selected area(s). In the process of this operation, 
right-clicking will cancel the operation. 

2. Press the Esc key to cancel this operation. 

#$k 3. An area that you use to Split can Split several selected areas at the same time. 

"topic-242-245 
topic-246 
interface preference 

* Interface Preference 
81 
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if you wish to modify the current interface, Sefect Interface Preference g from the View menu or click 
Preference g in the toolbar. 

Step by step Instructions 

Note. 

All the settings in the Preference dialog box will function as long as you click OK. Even if you exit 
AutoStitch and then enter it again, all the settings will remain unchanged unless you input new 
SettinCS. 9 

Step 1: Choose Tool Bar a 

Under the Toolbar, AutoStitch provides you with five checkboxes to check or uncheck five kinds of toolbars. 

o Checking the Standard A checkbox makes the Main toolbar visible on its default location (the top of the 
Picture and ObjectView window), otherwise it will be invisible. 

o Checking the Standard B checkbox makes the View toolbar visible on its default location (the right side of 
the ObjectView window), otherwise it will be invisible. 

e Checking the Object checkbox makes the Object toolbar visible on its default location (the bottom of the 
Picture and ObjectView window), otherwise it will be invisible. 

o Checking the Edit checkbox makes the Edit toolbar visible on its default location (the bottom of the Picture 
and ObjectView window), otherwise it will be invisible. 

o Checking the Other checkbox makes the Other toolbar visible on its default location (the bottom of the 
Picture and ObjectView window), otherwise it will be invisible. 

Tips: 

1. To change the position of the toolbar, double-click the blank space in the toolbar, so that the 
toolbar becomes an independent window. Left-click the blue title bar, hold down the left button and 
release it until you drag the dotted window frame to a proper position. In addition, the shape and size 
of the toolbar window can be changed in order to fit special requirement. 
Move the cursor to the border of the window, the cursor will become a double-direction arrow. 
According to your desired, drag it toward one of the two direction. 

2. Double-click any toolbar window in the suspended AutoStitch window to make resume its original 
position. 

3. To move toolbar window, you can also double-click the blank space of the toolbar and then right 
click the blue title bar. Select Move, a dotted frame of the window will appear. Use the direction keys: 
Up, Down, Left and Right to move it and press Enter key to make sure. 

4. To make the toolbar invisible, double-click the blank space of the toolbar and then click the close 
button on the upper-right corner or right-click the blue title bar in the present toolbar window and 
Select Property. To select Property is equal to uncheck the toolbar checkbox in the Interface 
Preference 

f 

Step 2: Choose Linear Measure (N a 
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Step 3: Choose Background Color (re a 

If you are not satisfied with the background color in the window or the background Color prevents you from 
viewing the stitches clearly, for example white, click Color under the Background option and select your 
desired color to be the new background color. 

Note: 

The new background color works for all windows in AutoStitch at the same time. For example, if you 
choose gray to be the new background color, the default background color of the window, the white 
Color, will become gray. 

Step 4: Choose Auto-Save Designs 
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Step 1: Access the Import dialog box al 

To access the import dialog box: 

: You can click import ... from the File menu. 

Step 2: Select the file's folder 4s at 

Using the following controls to select a folder: 

a Look in box 
e Up One Level button 

Contents List box 

Step 3: Select the File Type (s a. 

Select the file type from the File Of Type. 

1. Click on the drop down box. AutoStitch will open it. 

2. Click on your desired file type. If the file type is not visible, use the scrollbar to move through the list. 

Step 4: Select the file is a 

Click on your desired file in the Contents List box. If the file list is too long to fit in the box, use the scrollbar to 
move through it. 

Step 5: Select the Import button *(q. 

o import the design file or stitch file, click on the import button. 



US 2002/0183886 A1 Dec. 5, 2002 
91 

Step 1: Access the Export dialog box s 

To access the Export dialog box: 

You can click Export ... from the File menu. 

Step 2: Select or Create the file's folders a 

Selecting a folder 
Using the following controls select a folder. 

O Save in box 
Up One Level button 

o Contents List box 

Creating a folder 
1. Select the folder that will Contain the new folder. See the Section above. 

2. Click on the Create New Folder button. 
A: 

Step 3: Select the File Type (s c 

Select the file type from the File Of Type box. 

1. Click on the drop down box to open it. 

2. Click on your desired file type. If the file type is not visible, use the scrollbar to move through the list. 

Step 4: Enter the Filename is a 

Enter a name for the new file in the FileName Text box. Don't worry about the file extension, AutoStitch will 
add it automatically. 

1. Double-click in the text box. 

2. Type the filename. 

Step 5: Choose Machine Settings (s a 
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Step 6: Select the Save button (s 

Click on the Save button. One of two possibilities will happen: 

o AutoStitch will save the design and close the Export dialog box. 

o You will be asked if you want to replace an existing file. 

e Click on the Yes button to replace it. 

e Click on the No button to leave the file intact and return to the Export dialog box. 
SK 














































































































































































